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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals
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Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide

This guide describes how to configure and work with Reports in HP Business 
Availability Center.

This chapter includes:

 ➤  How This Guide Is Organized on page 7

 ➤  Who Should Read This Guide on page 8

 ➤  Getting More Information on page 8

How This Guide Is Organized

The guide contains the following parts:

 Part I Global Reports Components

Describes how to work with reports, the reports available in HP Business 
Availability Center, customizing reports, and analyzing reports logs. 

 Part II User Reports

Describes the pages and dialog boxes that are part of User Reports, which 
enable tracking of specific performance issues relevant to your organization 
or business unit's performance monitoring needs.
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Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Availability Center 
and enterprise monitoring and management concepts.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the HP Business Availability Center Deployment Guide PDF.



Part I

Global Reports Components
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1
Introducing Reports

This chapter provides general information on Reports.

This chapter includes:

Concepts

 ➤  Reports Overview on page 11

 ➤  HP Business Availability Center Reports on page 13

 ➤  Legacy Reports on page 33

Concepts

Reports Overview

Reports are available in the various applications contexts in HP Business 
Availability Center, and enable you to view and analyze performance data 
collected by HP Business Availability Center data collectors and stored in the 
HP Business Availability Center database. 

HP Business Availability Center provides the following types of reports: 

➤ Application Reports. Contain data displaying how well different areas of 
HP Business Availability Center are performing. Reports are categorized by 
the application they relate to: 

➤ Dashboard Reports. Display data collected from monitors, probes, and 
applications. For details on Dashboard reports, see “Dashboard Reports 
Overview” in Using Dashboard.



Chapter 1 • Introducing Reports

12

➤ End User Management Reports. Enable you to detect end-user business 
process issues before customers are impacted. For details on End User 
Management reports, see “End User Management Reports - Overview” in 
Using End User Management.

➤ Service Level Management Reports. Show you how well actual service 
levels compare with your goals. For details on Service Level Management 
reports, see “Service Level Management Reports - Overview” in Using 
Service Level Management. 

➤ System Availability Management Reports. Display information about 
how the servers and applications you are monitoring have performed 
over time. For details on System Availability Management reports, see 

➤ Alerts Reports. Enable you to view alert schedules configured for various 
HP Business Availability Center contexts. For details on Alerts Reports, 
see “Alerts Application” in Alerts.

➤ Universal CMDB Reports. Enable you to view and assess performance 
data collected by HP Business Availability Center and stored in the 
CMDB. For details on Universal CMDB Reports, see “Overview Report 
Overview” in Model Management.

➤ User Reports. Customized reports containing user-defined data and 
formatting that can help you focus on specific aspects of your organization's 
application and infrastructure resource performance. 

User reports include:

➤ Favorite Filters. For details, see “Favorite Filters” on page 91.

➤ Custom Reports. For details, see “Custom Reports” on page 123. 

➤ Trend Reports. For details, see “Trend Reports” on page 171.

➤ Service Reports. For details, see “Service Report” in Using My BAC.

➤ Custom Links. For details, see “New Custom Link Page” on page 119.

➤ Excel Reports. For details, see “Excel Reports” on page 92.

➤ Custom Query Reports. For details, see “Custom Query Builder” on 
page 197.
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User reports are configured in the Report Manager. For details on the Report 
Manager, see “Report Manager” on page 89.

You can also create a Schedule for User Reports to enable them to be sent to 
recipients at specified times. For details on creating schedules, see “Report 
Schedules” on page 92.

➤ Additional Reports. Reports that cannot be accessed directly from any 
application but that can be added to custom reports to provide additional 
information. For details on Additional Reports, see “Additional Custom 
Reports” on page 157.

HP Business Availability Center Reports

The following reports are available in HP Business Availability Center, 
arranged by context. 

These reports can be accessed via the specified contexts in HP Business 
Availability Center, and can also be assigned to Favorite Filters in the 
Favorite Filter Wizard, and to Custom Reports as report components via the 
Custom Report Wizard. Not all reports are available for each wizard. For 
details on configuring Favorite Filters, see “Favorite Filters Wizard” on 
page 114. For details on Custom Reports, see “Custom Reports” on 
page 123.

You can click the report name for a full description of the report.
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Alerts Reports

Reports Description

Actual vs Baseline 
Suggested Alerts Report

Enables you to compare the actual alerts that were 
triggered by user-defined thresholds and the 
Baselined Suggested alerts that would be triggered 
during the specified time range, for the selected 
Business Process Monitor profiles if you were using 
Baselining. For details, see “Actual vs Baseline 
Suggested Alerts Report” in Alerts.

Actual vs Baseline 
Suggested Alerts Report

Enables you to view, for each time period, whether 
the number of actual alerts that were triggered by 
user-defined thresholds is greater, equal, or smaller 
than the Baselined alerts that would be triggered 
during the specified time range, for the selected 
Business Process Monitor profiles if you were using 
Baselining. For details, see “Actual vs Baseline 
Suggested Alerts Report” in Alerts.

Alerts Count Over Time 
Report

Enables you to display, for the selected profile, the 
number of alerts that occurred over the specified 
time range, organized by time and severity. For 
details, “Alerts Count Over Time Report” in Alerts.

Alerts Count Summary 
Report

Enables you to display, for the selected profile, the 
total number of alerts that occurred over the 
specified time range, organized by severity. For 
details, see “Alerts Count Summary Report” in Alerts.

Alerts Log Report Enables you to track all alert details for event-based 
alerts sent by HP Business Availability Center during 
the specified time range, for the selected Business 
Process Monitor profiles, or Real User Monitor, 
regardless of the action specified for the alert in the 
alert scheme. For details, see “Alerts Log Report” in 
Alerts.
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Application Change Lifecycle Reports

Baseline Suggested Alerts 
Log Report

Enables you to track all alert details for event-based 
alerts that would be sent by HP Business Availability 
Center during the specified time range, for the 
selected Business Process Monitor profiles, or Real 
User Monitor, regardless of the action specified for 
the alert in the alert scheme, if you were using 
Baselining. For details, see “Baseline Suggested Alerts 
Log Report” in Alerts.

Configuration Item Status 
Alerts Report

Enables you to list all of the alerts that occurred in 
the specified period of time. For details, see 
“Configuration Item Status Alerts Report” in Alerts.

SLA Status Alerts Report Lists the alerts that were triggered during a specified 
time period. For details, see “SLA Status Alerts 
Report” in Alerts.

Reports Description

Location Load Analysis 
Report

Enables you to view the transaction load (the 
number of Real User Monitor transaction runs) and 
bit rate (bits per second) per end-user location. For 
details, see “Location Load Analysis Report” in 
Solutions and Integrations. 

Typical Transaction Load 
Report

Enables you to view the average transaction load 
(the number of Real User Monitor transaction runs) 
during a typical hour, day, or week within a larger 
time frame that you select. For details, see “Typical 
Transaction Load Report” in Solutions and 
Integrations.

Reports Description
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Application Performance Lifecycle Reports

Business Process Insight Reports

Reports Description

Business Process 
Distribution Page

Enables you to view transaction run and transaction 
response time data over time for the configured 
transactions monitored by the Real User Monitor, 
and create VuGen script templates that can be used 
in a Performance Center load test. For details, see 
“Business Process Distribution Page” in Using 
Application Performance Lifecycle.

Location Load Analysis 
Report

Enables you to view the transaction load (the 
number of Real User Monitor transaction runs) and 
bit rate (bits per second) per end-user location. For 
details, see “Location Load Analysis Report” in Using 
Application Performance Lifecycle.

Typical Transaction Load 
Report

Enables you to view the average transaction load 
(the number of Real User Monitor transaction runs) 
during a typical hour, day, or week within a larger 
time frame that you select. For details, see “Typical 
Transaction Load Report” in Using Application 
Performance Lifecycle.

Reports Description

BPI Monitors Over Time 
Report

Displays two graphs for each selected BPI Duration 
Monitor CI or BPI Custom/Value Monitor CI. For 
details, see “BPI Monitors Over Time Report” in 
Using Dashboard.

Business Process Over 
Time Report

Displays information about the volume, backlog, 
and health of the selected Business Process CI, over 
the selected time period. For details, see “Business 
Process Over Time Report” in Using Dashboard.

Business Process 
Summary Report

Displays the summary data of the selected Business 
Process CIs. For details, see “Business Process 
Summary Report” in Using Dashboard.
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Dashboard Reports

Reports Description

KPIs Summary Report Displays a summary of KPI status distribution over 
time for each selected KPI. For details, see “KPIs 
Summary Report” in Using Dashboard.

KPIs Trend Report Enables you to analyze the trend for changes in KPI 
status over time, for selected statuses. For details, see 
“KPIs Trend Report” in Using Dashboard.

KPIs Distribution Over 
Time Report

Enables you to analyze KPI trend by viewing KPI 
status distribution over time for selected statuses. For 
details, see “KPIs Distribution Over Time Report” in 
Using Dashboard.

KPIs Over Time Report Displays the status or value, over time, of selected 
CIs and KPIs that are accessible from the Dashboard 
application. For details, see “KPIs Over Time Report” 
in Using Dashboard.

Business Processes 
Summary, Business 
Process Over Time, BPI 
Monitors Over Time 
Reports

Display the information needed to monitor 
HP Business Process Insight. For details, see Display 
the information needed to monitor HP Business 
Process Insight. For details, see “BPI Monitors Over 
Time Report”, “Business Process Over Time Report”, 
or “Business Process Summary Report” in Using 
Dashboard.

Business Transaction 
Summary, Business 
Transaction Over Time

Displays summarized information for selected 
business transactions monitored by 
HP TransactionVision, and information over time 
for specific transactions. For details, see “Business 
Transaction Over Time Report” and “Business 
Transaction Summary Report” in Using Dashboard.
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End User Management Reports

Snapshot Status Report

Summary Reports

Reports Description

End User Management 
Status Snapshot

Displays a summary of the five worst transactions 
and locations for Business Process Monitor for the 
last day. For Real User Monitor, End User 
Management displays the five worst sessions (that is, 
the least available) and the slowest applications. For 
details, see “Status Snapshot” in Using End User 
Management.

Network and Tool Reports Displays reports that help you identify problems 
along the network.

Report data is based on WebTrace/Traceroute 
monitor data.

For details, see “Network Reports and Tools 
Overview” in Using End User Management.

Reports Description

Multi-Profile Summary 
Report

Displays an overall snapshot of application 
performance for multiple Business Process profiles. 
For details, see “Multi-Profile Summary Report” in 
Using End User Management.

Performance Matrix 
Report

Displays a distribution of average transaction 
response times—organized by transaction, location, 
or group—over a specified period of time. For details, 
see “Performance Matrix Report” in Using End User 
Management. 
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Business Process Reports

Single Profile Summary 
Report

Displays a quick snapshot of application 
performance for a specific Business Process profile. 
For details, see “Single Profile Summary Report” in 
Using End User Management.

Triage Report Displays transaction data for Business Process 
Monitor profiles, organized by location, for the past 
day or for any selected 24 hours. For details, see 
“Triage Report” in Using End User Management.

Reports Description

Availability Over Time 
Report

Displays the percentage of successful transactions 
performed by all hosts in a profile—organized by 
transaction, location, or group—over time. For 
details, see “Availability Over Time Report” in Using 
End User Management.

Breakdown Over Time 
Report

Displays a color-coded graph showing the average 
transaction breakdown category response times (in 
milliseconds) of a profile’s transactions over time. 
For details, see “Breakdown Over Time Report” in 
Using End User Management.

Breakdown Summary 
Report

Displays a color-coded graph that breaks down 
transaction times into categories, enabling you to 
determine whether poor transaction response times 
are being caused by network or server problems, or 
by client delays. For details, see “Breakdown 
Summary Report” in Using End User Management.

Reports Description
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Error Summary Report Displays detailed tables—organized by error type—of 
errors that occurred during a profile run, over the 
specified time period. Since not all errors cause 
transactions to fail, the Error Summary report 
includes errors for transactions that completed 
successfully as well as transactions that failed. The 
report also lists outlier transactions. For details, see 
“Error Summary Report” in Using End User 
Management.

Failed Transactions Report Displays details about errors that occur during a 
script run. You also access the Snapshot on Error 
feature from the Failed Transaction report. For 
details, see “Failed Transactions Report” in Using End 
User Management.

Location Analysis Report Displays an in-depth picture of the performance of 
locations. The report enables you to understand, for 
the selected profile and defined time frame:

➤ the average response times of your transactions 
over time for each location in the profile

➤ how well your locations performed relative to the 
set transaction thresholds

For details, see “Location Analysis Report” in Using 
End User Management.

Min./Max. Response Time 
Report

Displays the minimum, average, and maximum 
response time (in seconds) of completed 
transactions—organized by transaction, location, or 
group—for the selected time frame. For details, see 
“Min./Max. Response Time Report” in Using End User 
Management.

Response Time by 
Percentile Report

Displays, for the defined time range, the specific 
response time value that all measured response time 
values are equal to or below, for calculated 
percentiles. For details, see “Response Time by 
Percentile Report” in Using End User Management.

Reports Description
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Response Time Over Time 
Report

Displays the average response times (in seconds) of 
completed transactions—organized by transaction, 
location, or group—over time. For details, see 
“Response Time Over Time Report” in Using End User 
Management.

Transaction Analysis 
Report

Displays an in-depth picture of the performance of 
transactions. The report enables you to understand, 
for the selected profile and defined time frame:

➤ the average response times of your transactions 
over time

➤ whether poor transaction response times are 
being caused by network or server problems, or by 
client delays

➤ the availability level of your transactions

➤ how well your transactions performed relative to 
set transaction thresholds

For details, see “Transaction Analysis Report” in 
Using End User Management.

Transaction Breakdown 
Raw Data Report

Displays a summary of every instance of the 
transaction that occurred during the selected time 
range. For details, see “Transaction Breakdown Raw 
Data Report” in Using End User Management.

Triage Raw Data Report Displays performance and availability raw data for a 
Business Process Monitor transaction. For details, see 
“Triage Raw Data Report” in Using End User 
Management.

Network and Tool reports Displays reports that help you identify problems 
along the network.

Report data is based on WebTrace/Traceroute 
monitor data.

For details, see “Network Reports and Tools 
Overview” in Using End User Management.

Reports Description
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Network Reports

Reports Description

Network Analysis Report Displays an in-depth picture of network 
performance for a Business Process profile, if you 
defined a WebTrace monitor for the profile. For 
details, see “Network Analysis Report” in Using End 
User Management. 

Page Component 
Breakdown Report

Displays an on-demand component breakdown of 
any Web page. For details, see “Page Component 
Breakdown Report” in Using End User Management. 

WebTrace by Location 
Report

Displays typical traceroute information from 
configured host locations to specified destinations, 
enabling you to analyze network performance. For 
details, see “WebTrace by Location Report” in Using 
End User Management. 

WebTrace Measurements 
Report

Displays WebTrace data with increased time 
granularity. For details, see “WebTrace 
Measurements Report” in Using End User 
Management. 

WebTrace Over Time 
Report

Displays additional route time and hop information 
that helps you determine at exactly which point 
along the network path bottlenecks are occurring. 
For details, see “WebTrace Over Time Report” in 
Using End User Management. 
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Real User Monitor

Reports Description

Business Process 
Distribution Report

Displays transaction run and transaction response 
time data over time for the transactions that you 
configure in End User Management Administration. 
For details, see “Business Process Distribution 
Report” in Using End User Management. 

End User Over Time 
Report

Displays a selected end-user group’s hits, latency, 
events, requests, and traffic over the course of time. 
For details, see “End User Over Time Report” in Using 
End User Management.

End User Summary Report Displays data for specific end-user groups that were 
configured for Real User Monitor in End User 
Management Administration. Also displays 
aggregated data for unconfigured end-user groups, 
which is displayed grouped by country, or if the 
country is unknown, then grouped as OTHER. For 
details, see “End User Summary Report” in Using End 
User Management.

End Users by Page Report Displays data for a selected Web page configured for 
Real User Monitor in End User Management 
Administration, broken down by end-user groups. 
For details, see “End Users by Page Report” in Using 
End User Management.

End Users by Transaction 
Report

Displays general, availability, and performance data 
for each end-user group that ran the transaction you 
selected in the Transaction Summary report. For 
details, see “End Users by Transaction Report” in 
Using End User Management.

Event Analysis Report Displays data for a selected event type, broken down 
by pages, servers, and end-user groups. Also displays 
the Event Count Over Time report for the selected 
event type. For details, see “Event Analysis Report” 
in Using End User Management.
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Event Count Over Time 
Report

Displays data for all events, or sessions with events, 
in monitored applications that you configured in 
End User Management Administration, broken 
down by time intervals. For details, see “Event 
Count Over Time Report” in Using End User 
Management.

Event Summary Report Displays a summary of events in monitored 
applications that you configured in End User 
Management Administration. For details, see “Event 
Summary Report” in Using End User Management.

Global Statistics Report Contains tables displaying general page, end-user, 
and broken link data that is not related to the 
specific pages and end-users that you define for Real 
User Monitor in End User Management 
Administration. For details, see “Global Statistics 
Report” in Using End User Management.

Page Over Time Report Displays details of the availability, performance, hits 
availability, and breakdown for the selected Web 
page over the course of time. For details, see “Page 
Over Time Report” in Using End User Management.

Page Summary Report Displays data for specific Web pages that were 
configured for Real User Monitor in End User 
Management Administration. For details, see “Page 
Summary Report” in Using End User Management.

Pages by Server Summary 
Report

Displays a table showing each page hit by the server 
for which you are viewing data. For details, see 
“Pages by Server Summary Report” in Using End User 
Management.

Server Over Time Report Displays graphs and tables of the server’s availability, 
traffic, requests, and errors over the course of time. 
For details, see “Server Over Time Report” in Using 
End User Management.

Server Summary Report Displays data for the servers that are monitored by 
the Real User Monitor probe. For details, see “Server 
Summary Report” in Using End User Management.

Reports Description
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Servers by Page Summary 
Report

Displays a table showing each server used in 
accessing the page for which you are viewing data. 
For details, see “Servers by Page Summary Report” in 
Using End User Management.

Session Analyzer Report Displays session data for specific applications that 
were configured for Real User Monitor in End User 
Management Administration. Sessions in 
applications that have not been configured for 
monitoring are also reported as part of a default 
entity for other applications, called <engine name>’s 
other applications. For example, for a configured 
Real User Monitor engine called myengine, the 
default entity for non-monitored applications is 
myengine’s other applications.

For details, see “Session Analyzer Report” in Using 
End User Management.

Session Details Report Displays details of a session and includes panes 
showing data for Properties, General Events, and 
Pages. For details, see “Session Details Report” in 
Using End User Management.

TCP Application Over 
Time Report

Displays a selected application’s traffic, errors, load, 
and response times over the course of time. For 
details, see “TCP Application Over Time Report” in 
Using End User Management.

TCP Application 
Summary Report

Displays data for specific TCP applications, as well as 
for Web (HTTP) applications with TCP settings, that 
were configured for Real User Monitor in End User 
Management Administration. For details, see “TCP 
Application Summary Report” in Using End User 
Management.

Transaction Over Time 
Report

Displays details of the availability, page times, run 
availability, and breakdown for the selected 
transaction, over the course of time. For details, see 
“Transaction Over Time Report” in Using End User 
Management.

Reports Description
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Transaction Summary 
Report

Displays data for specific transactions that were 
configured for Real User Monitor in End User 
Management Administration. For details, see 
“Transaction Summary Report” in Using End User 
Management.

Unconfigured End Users 
by Country/State, City, or 
IP

Displays data for the end-users included in a country 
or state selected in the Unconfigured End Users by 
Country/State report, grouped by city. For details, 
see “Unconfigured End Users by Country/State, City, 
or IP” in Using End User Management.

Unconfigured End Users 
by Country/State, City, or 
IP

Displays data for the end-users included in an 
unconfigured end-user group selected in the End 
User Summary report, grouped by country and state. 
For details, see “Unconfigured End Users by 
Country/State, City, or IP” in Using End User 
Management.

Unconfigured End Users 
by Country/State, City, or 
IP

Displays data for the end-users included in a city 
selected in the Unconfigured End Users by City 
report, grouped by IP address. For details, see 
“Unconfigured End Users by Country/State, City, or 
IP” in Using End User Management.

Network and Tool Reports Displays reports that help you identify problems 
along the network.

Report data is based on WebTrace/Traceroute 
monitor data.

For details, see “Network Reports and Tools 
Overview” in Using End User Management.

Reports Description
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Service Level Management Reports

Status Snapshot Report

SLA Reports

Report Name Description

Status Snapshot Report Displays up-to-date information about the worst-
performing agreements in the current tracking 
periods, and in previous, closed periods.

For details, see “Status Snapshot Report” in Using 
Service Level Management.

Report Name Description

SLA Status Report Displays current and forecast status for agreements 
over a selected tracking period. Use to determine if 
current service levels may lead to a future breach of 
the agreement.

For details, see “SLA Status Report” in Using Service 
Level Management.

SLAs Summary Report Displays a list of agreements and their status, 
organized by KPI/calendar/time period. Use to view 
a summary of data for all (or specific) agreements.

For details, see “SLAs Summary Report” in Using 
Service Level Management. 

CI Summary Report Drill-down from the SLA Summary report. The 
report displays status for CIs in the branch for a 
selected CI (up to four levels), organized by 
KPI/calendar/time period. Use to find CIs that did 
not reach their objectives. For details, see “CI 
Summary Report” in Using Service Level Management.
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CI Impact Report Displays a CI’s impact across several agreements. The 
report displays status organized by 
KPI/calendar/time period. Use to compare the 
availability and performance of a CI across several 
agreements.

For details, see “CI Impact Report” in Using Service 
Level Management.

CI Status Report Displays status for CIs in the branch for a selected CI 
(up to four levels), for a selected time range, 
calendar, and KPI. Use to view configuration 
information, such as objectives, for each CI.

For details, see “CI Status Report” in Using Service 
Level Management.

Time Range Comparison 
Report

Enables you to compare status for up to eight time 
ranges for CIs in an agreement.

Displays status for CIs in the branch of a selected CI 
(up to four levels), for a selected calendar and KPI.

The added value in this report is that it displays a 
trend between two time ranges.

Use to compare time ranges to determine whether 
availability and performance have improved. 

For details, see “Time Range Comparison Report” in 
Using Service Level Management.

Report Name Description
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Outage Reports

CIs Over Time Report Displays a graphic display of status over time for 
selected CIs, for a specific KPI and calendar. Use to 
follow the results of a particular CI over a time 
period and compare with other CIs.

For details, see “CIs Over Time Report” in Using 
Service Level Management.

CI Over Time vs. Target 
Report

Displays a graphic display of status over time for a 
selected CI, for a specific KPI and calendar, and 
compares results to the target objectives for the CI. 
Use to see how well a CI has performed compared to 
its objectives.

For details, see “CI Over Time vs. Target Report” in 
Using Service Level Management.

Report Name Description

Outage Summary Report Displays a list of outages for selected CIs. Use to view 
outage information for a specific agreement.

For details, see “Outage Summary Report” in Using 
Service Level Management.

Report Name Description
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SOA Reports

Outage Breakdown Report Displays a graphic display for breakdown of outage 
categories by CI outages, or a breakdown of CI 
outages by outage categories. You view data 
according to outage duration or number of outages, 
for a specific calendar. Use to view a breakdown of 
all outages for certain CIs, to see to which category a 
CI belongs (Database, Network, Webserver, 
Undefined, or user-defined).

For details, see “Outage Breakdown Report” in Using 
Service Level Management.

Outage Distribution 
Report

Displays a graphic display of outage distribution by 
CI or by outage category. You view data according to 
outage duration or number of outages, for a specific 
calendar. Use to view the outage distribution for 
selected CIs, to see which CI or category has the 
most outages, or has outages with the longest 
duration. 

For details, see “Outage Distribution Report” in Using 
Service Level Management.

Reports Description

Consumer Summary 
Report

Displays specific metrics for all of the consumers 
accessing the selected Web services or operations in 
a selected view. For details, see “Consumer Summary 
Report” in Solutions and Integrations.

Health Report Displays health metrics for the selected Web 
service(s), operation(s), server, endpoint, or 
consumer in a selected view. For details, see “Health 
Report” in Solutions and Integrations.

Metrics Over Time Report Displays the performance of selected metrics related 
to a selected view and selected CIs, over time. For 
details, see “Metrics Over Time Report” in Solutions 
and Integrations.

Report Name Description
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System Availability Management Reports

Server and Endpoint 
Summary Report

Displays a drillable summary of the metrics for all of 
the servers or endpoints on which the selected Web 
services or operations of a selected view are running. 
For details, see “Server and Endpoint Summary 
Report” in Solutions and Integrations.

Top Metrics Report Displays the top metrics information about the 
traffic to and from all of the monitored Web services 
or operations in a specific view. For details, see “Top 
Metrics Report” in Solutions and Integrations.

Report Name Description

Monitor Performance 
Report

Displays the best- or worst-performing SiteScope 
monitors across various SiteScope categories. 

For details, see “Monitor Performance Report” in 
Using System Availability Management. 

Cross-Performance Report Displays data from more than one SiteScope server 
filtered by monitored servers, monitor types, and 
measurements. For details, see “Cross-Performance 
Report” in Using System Availability Management. 

Group Performance 
Report

Displays the infrastructure machine resource usage 
data for the monitors in the selected group and its 
subgroups. For details, see “Group Performance 
Report” in Using System Availability Management. 

Status Summary Report Displays a quick snapshot of the performance of 
monitored infrastructure machines, organized by 
SiteScope group. For details, see “Status Summary 
Report” in Using System Availability Management. 

Reports Description
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TransactionVision Reports

Warning Summary Report Displays a list of the monitors, for the selected group 
and its subgroups, whose measurements fell within 
the minor threshold level during the selected time 
period. For details, see “Warning Summary Report” 
in Using System Availability Management. 

Error Summary Report Displays a list of the monitors, for the selected group 
and its subgroups, whose measurements returned 
errors during the selected time period. For details, 
see “Error Summary Report” in Using System 
Availability Management. 

Reports Description

Transaction Over Time 
Report

Displays details of the availability, page times, run 
availability, and breakdown for the selected 
transaction, over the course of time. For details, see 
“Transaction Over Time Report” in Using End User 
Management. 

Transaction Summary 
Report

Displays data for specific transactions that were 
configured for Real User Monitor in End User 
Management Administration. For details, see 
“Transaction Summary Report” in Using End User 
Management. 

Report Name Description
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Universal CMDB Reports

Legacy Reports

Certain report functionalities are not supported in HP Business Availability 
Center Legacy Reports. These elements are indicated in the table in 
“Common Report Elements” on page 51. 

The following table outlines the HP Business Availability Center Legacy 
Reports, arranged by application:

Report Name Description

Asset Report Displays a list of all the CIs in a specified view, their 
attribute values, as well as their child CI’s in the 
CMDB. For details, see “Asset Report” in Model 
Management. 

“Change Report” Enables you to view and analyze the actual changes 
made to a specific CI and its children. For details, see 
“Change Report” in Model Management. 

Host Dependency Report Lists all the relationships of the type Dependency 
that connect between servers in the selected view, or 
between the servers in the CMDB and the servers 
within the selected view. For details, see “Host 
Dependency Report” in Model Management.

System Report Gives you information about the selected Report 
nodes in the TQL on which it is based. For details, 
see “System Report” in Model Management. 

Application Reports

End User Management - 
Summary Reports

Multi-Profile Summary Report

Single Profile Summary Report

Performance Matrix Report
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End User Management - 
Business Process Reports

Availability Over Time Report

Response Over Time Report

Transaction Analysis Report

System Availability 
Management

Monitor Performance Report

Group Performance Report

Status Summary Report

Warning Summary Report

Error Summary Report

Application Reports
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2
Working in Reports

This chapter includes the main concepts, tasks, and reference information 
for Working in Reports.

This chapter includes:

Concepts

 ➤  Working in Reports - Overview on page 36

 ➤  Generating Reports on page 37

 ➤  Report Annotation on page 40

 ➤  Viewing Reports with Adobe Flash Player on page 40

Tasks

 ➤  Generate Reports on page 41

 ➤  Configure Report Generation Settings on page 44

Reference

 ➤  Working in Reports User Interface on page 44

Troubleshooting and Limitations on page 68
Concepts
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Working in Reports - Overview

Reports consist of charts and tables that help you track and analyze the 
health of your monitored environment. You view and generate reports, as 
well as drill down and apply various filtering criteria to examine 
performance trends and pinpoint the cause of availability and performance 
issues.

Reports enable you to examine and analyze the data that HP Business 
Availability Center collects. When generating reports, you can specify 
various report settings, including time range and resolution, profile, 
grouping, and filters.

You can also customize reports by adding a header and a footer, by selecting 
to automatically or manually generate the report, or by customizing other 
display elements. For details, see “Report Manager” on page 89. 

For details on navigation functions, see “Navigating HP Business Availability 
Center” in Platform Administration.

Note: HP Business Availability Center presents certain reports within the 
context of transaction thresholds. For details on configuring transaction 
thresholds, see “Transaction Threshold Settings” in Using End User 
Management.

The Annotation Tool enables you to generate a snapshot of select reports on 
which you can highlight important areas of the report. For details, see 
“Report Annotation” on page 40.

Certain user interface elements are common to most report pages. For 
details, see “Common Report Elements” on page 51.
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Generating Reports

You generate reports to enable receiving data in an organized format. 
Certain reports are initially generated automatically, whereas for others you 
must specify report criteria and generate the report manually. For a list of 
report elements used for report generation that are common to most 
reports, see “Common Report Elements” on page 51.

You can configure HP Business Availability Center to generate reports 
automatically after selecting the report from the menu or to generate reports 
only on demand from within the report. For details, see “Configure Report 
Generation Settings” on page 44.

You can configure the time range and granularity for which the report 
should be generated. The granularity determines how many measurement 
samples are displayed in the report per time interval. By default, reports are 
limited to a maximum of 32 samples (trend reports have a maximum of 50 
samples). Thus, for example, if you select the “Day” time range and the 
“minutes” granularity, since there are 1,440 minutes in a day and a 
maximum of 32 samples on a chart, the granularity ranges from “every 45 
minutes” (1440/32=45) to “every 59 minutes” (above 59 minutes, you use 
the “hour” granularity unit).

Additional examples:

➤ If you select the Day time range and a granularity of every 1 hour, the 
report is displayed using 24 samples (1 hour x 24 = 1 day).

➤ If you select the Month time range and a granularity of every 1 week, the 
report is displayed using 4 samples (1 week x 4 = 1 month). 

You can modify the allowed number of samples in reports in the 
Infrastructure Settings Manager. To do so, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, click Foundations, select End 
User/System Availability Management, and locate the Max Data Points in 
Report parameter entry in the Data table. Modify the value to the required 
amount.

For details on using the Infrastructure Settings Manager, see “Infrastructure 
Settings” in Platform Administration.
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Note: 

➤ In certain reports, the selected time range is displayed along the x-axis. 
HP Business Availability Center breaks down the time range according to 
segments that differ depending on the selected time range. For details, 
see “Report Times” in Reference Information.

➤ Depending on the time range you select, HP Business Availability Center 
generates reports using either raw data or aggregated data. A note is 
displayed in the report when aggregated data is used. For details, see 
“How Reports Use Aggregated Data” in Reference Information.

For details on configuring the time range and granularity for reports, see 
“Time Range and Granularity Bar” on page 66.

You can generate reports from the following locations in HP Business 
Availability Center.

➤ In the various Reports tabs located in the End User Management, Service 
Level Management, and System Availability Management contexts under 
the Applications menu item.

➤ In the Reports Repository Manager, accessed from the User Reports 
context under the Applications menu item. For details on the Reports 
Repository Manager, see “Report Manager” on page 89.

You apply filtering criteria to examine performance issue trends and 
pinpoint the cause of availability and performance issues. You can save your 
filter configurations as a Favorite Filter, to be used again for generating other 
reports of the same report type. For details, see “Save Filter to Favorites 
Dialog Box” on page 65.

You can also generate a Favorite Filter from outside the reports pages, using 
the Favorite Filters wizard in the Reports Repository Manager. For details, see 
“Favorite Filters Wizard” on page 114.

You can also choose from various options for publishing a report, for 
individuals who do not usually work with HP Business Availability Center. 
For details on publishing reports, see “Publishing a Report” on page 39.
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Publishing a Report
You can generate up-to-date reports that can be viewed by users who do not 
usually work with HP Business Availability Center, and, therefore, do not 
know how to create reports. However, these users must have a network 
connection to HP Business Availability Center to view the report. You 
publish the reports in .csv format, Excel format, .xml format, or printer-
friendly format, and send the report (generally, by email) to the user. 

The report contains data that is updated when the report is accessed. For 
example, say you prepare a report for the past month (24 Oct 2005 8:00 AM 
– 21 Nov 2005 8:00 AM), publish the report, and send the URL or an HTML 
file of the report to a user. The user accesses the report a week later (on 28 
Nov 2005), at which time the report shows the updated past month 
(31 Oct 2005 8:00 AM – 28 Nov 2005 8:00 AM).

If you define a time period using the Custom option, the report always 
shows data reflecting the customized time period, no matter when the user 
accesses the report.

You would probably publish reports that use a relative tracking period (for 
example, past month, month to date), as it may not be useful to publish 
reports that use an absolute tracking period (for example, hour, day, 
month).

You can choose between two methods for publishing reports: URL and 
HTML. Use URL to submit the form with a GET method (recommended), 
and HTML to submit the form with a POST method.

Tip: When publishing a report, choose only from tracking periods that show 
data when the user accesses the report. For example, if you know that the 
monitor being tracked by the profile is going down shortly, and you are 
setting up a report to show data, ensure that you have configured the report 
to show data for a time when the monitor is up and running. Otherwise, the 
user’s report does not include data. 
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Report Annotation

The Annotation Tool creates a snapshot of the report you are viewing and 
enables you to highlight important areas of the report by drawing shapes, 
lines, and adding text to the snapshot. Annotated reports can be shown to 
others to emphasize exceptional areas of the report, uploaded to the Report 
Manager, or saved to your local directory.

The Annotation Tool is accessible by clicking the Annotation Tool button on 
the right side of the page.

The actions you can perform with your annotation are:

➤ Print the annotation.

➤ Save a snapshot of the annotation in .png format to your local machine.

➤ Send the annotation via email.

Viewing Reports with Adobe Flash Player

HP Business Availability Center utilizes Adobe Flash Player technology in 
selected reports to render report charts, to control the flow of information, 
and add interest to your reports. 

You must have Flash Player version 8.0 or later installed on your machine. If 
you do not, the browser displays a message containing instructions on 
downloading Flash Player. 

Pie charts in Flash reports have the following functionality, available via the 
context menu:

➤ Enable Rotation. When this option is selected, you can click and drag to 
rotate the pie. Toggles with Enable Slicing Movement.

➤ Enable Slicing Movement. When this option is selected, you can click a pie 
slice to slide it out from the main pie. Toggles with Enable Rotation.

➤ View 2D/View 3D. Toggle between these options as required.
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By default, the KPIs Distribution Over Time, KPIs Summary, and KPIs Trend 
reports (available in Dashboard and My BAC Business Dashboard) use Flash 
with a built-in one second delay for rendering the reports. If required, you 
can remove the delay (so that the reports are immediately displayed fully 
rendered). To remove the delay, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Reports Delay Time entry in the 
Business Reports Properties table. Modify the value to False.

Tasks

Generate Reports

This task describes how to generate reports to track and analyze the health 
of your monitored environment. 

This task includes the following steps:

➤ “Access the Report Page” on page 41

➤ “Choose the Time Range and Granularity” on page 41

➤ “Configure Report Parameters” on page 42

➤ “Save Filter to Favorites” on page 42

➤ “Results” on page 43

 1 Access the Report Page
Access the relevant report page where you want to configure reports. For 
details on the reports contexts, see “Generating Reports” on page 37.

 2 Choose the Time Range and Granularity
When generating a report, you choose the time range and granularity in 
which the report is displayed. For details on configuring the time range and 
granularity for reports, see “Time Range and Granularity Bar” on page 66.

For additional information on choosing the time range and granularity in 
Service Level Management, see “Tracking Range and Granularity in Service 
Level Management” in Using Service Level Management.
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 3 Configure Report Parameters
You configure the parameters of your report, and optionally apply filtering 
criteria to receive specific data for the report. For details on the various 
elements used to configure reports that are common to most reports, see 
“Common Report Elements” on page 51.

Example

 a Click Profiles and Active Filters links to select the relevant profiles and 
active filters to be monitored by the report. 

 b Choose the time range for the report in the Time Range and Granularity 
bar. 

 c Optionally, choose from the following: 

➤ Click the Format button to choose a format for production of the report.

➤ Click the Export button to choose a format in which to transfer the 
report data, either via email, publishing, or uploading to the report 
repository.

➤ Add annotations to the report. For details on the user interface for 
annotating reports, see “Annotation Tool Window” on page 45.

➤ Configure a Favorite Filter for the report. For details, see “Save Filter to 
Favorites Dialog Box” on page 65.

 d Click Generate to generate the report.

 4 Save Filter to Favorites
Optionally, you can save your configured report filters to be used again for 
generating other reports. For details on the user interface for configuring a 
favorite filter, see “Save Filter to Favorites Dialog Box” on page 65
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Example

Click the Favorite Filters button on the right side of the screen to open the 
Save Filter to Favorites dialog box.

After saving, the filter appears under the specified access level (Private or 
Public) in the Favorite Filters drop down.

You select a Favorite Filter and click Generate to generate a report according 
to the specific filter’s parameters. 

 5 Results
The report’s parameters appear in the collapsible pane above the report.

If you configured a Favorite Filter for the report, you can select the 
configured filter from the Favorite Filters drop down. The selected filter is 
now configured as the parameters by which the new report is generated.
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Configure Report Generation Settings

To configure the report generation settings in HP Business Availability 
Center, users with appropriate administrative privileges should perform the 
changes described in the procedure below. 

Note: You must have appropriate administrative privileges to configure 
these settings.

To configure report generation settings for reports:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Foundations, select Reporting and locate the Generate reports 
automatically entry in the Reporting-Display table. 

 2 Click the Edit button  and set the property value as required:

➤ select true to enable automatic report generation

➤ select false to disable automatic report generation

To restore default settings, click the Restore Default button.

Reference

Working in Reports User Interface

This section describes:

 ➤  Annotation Tool Window on page 45

 ➤  Common Report Elements on page 51

 ➤  Format Options on page 56

 ➤  Export Options on page 58

 ➤  Save Filter to Favorites Dialog Box on page 65

 ➤  Time Range and Granularity Bar on page 66
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Annotation Tool Window

Annotation Options

Description Enables you to annotate a snapshot of the report you are 
viewing, to highlight important areas.

To access: Click the Annotate button  on the right 
side of the page.

Important 
Information

When saving the annotation: 

➤ The snapshot is saved in .png format.

➤ You cannot select the New Folder icon  when 
saving in the My Documents directory or any of its 
subdirectories. 

Included in Tasks “Generating Reports” on page 37

Useful Links “Report Annotation” on page 40

Description The elements which enable you to customize your 
snapshot.

To access: Click the Annotate button  on the right 
side of the report page. The annotation options are 
located on the left side of the annotation window.

Useful Links “Report Annotation” on page 40
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The following elements are included:

GUI Element (A–Z) Description

Click to navigate the snapshot.

Click to select a specific area of the snapshot.

Click to add a shape to the snapshot. Clicking the shape 
tool button enables the following shape buttons:

➤  Click to mark an area of the snapshot with a 
rectangle.

➤  Click to mark an area of the snapshot with a filled 
rectangle.

➤  Click to mark an area of the snapshot with an 
oval.

➤  Click to mark an area of the snapshot with a filled 
oval.

➤  Click to mark an area of the snapshot with a 
round rectangle. 

➤  Click to mark an area of the snapshot with a filled 
round rectangle. 

Customization. After selecting this button, you can 
customize your line appearance through the following 
parts of the interface:

➤ Line Type. Choose the type of line you want to add. 
Options include:

➤ Solid Line

➤ Jagged Line

➤ Line Width. Select the width of the line, in pixels, in 
the annotation.
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Click to enable the line tool, which marks the selected 
area of the snapshot with a line. 

Customization. After selecting this button, you can 
customize your line appearance through the following 
parts of the interface:

➤ Line Style. Choose the style of line you want to add. 
Options include: 

➤ Regular line

➤ Line with endpoints

➤ Line with arrows

➤ Line Type. Choose the type of line you want to add. 
Options include:

➤ Solid Line

➤ Jagged Line

➤ Line Width. Select the width of the line, in pixels, in 
the annotation. 

Click to add text to the snapshot.

Example: Add, This is the problematic transaction above a 
line marking an area of the report.

GUI Element (A–Z) Description
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Border and Fill Colors Select the relevant square to choose the color of the 
border and fill of your annotations. The available squares 
are:

➤ Upper Square. Click to choose the color of lines, as 
generated by the line tool and displayed in unfilled 
shapes. 

➤ Lower Square. Click to choose the color to fill shapes.

Clicking either of the squares generates a dialog box with 
the following tabs where you choose the color:

➤ Swatches 

➤ HSB

➤ RGB

Opacity Slide the opacity bar to choose the darkness level of the 
selected shape line, text line, or shape color in the 
annotation. 

Notes: 

➤ A higher opacity percentage means that the selection 
appears darker. A lower opacity percentage means that 
the selection appears lighter.

➤ This field is enabled when either the shape tool, line 
tool, or text tool button is selected.

GUI Element (A–Z) Description



Chapter 2 • Working in Reports

49

Menu Bar

The following elements are included:

Description Displays the elements which enable you to perform 
selected actions on your snapshot. 

To access: Click the Annotate button  on the right 
side of the report page.

Important 
Information

The menu bar contains elements which enable you to:

➤ Change the appearance of the snapshot.

➤ Save, print, email, or upload an annotation report to 
the Report Repository.

➤ Customize the appearance of text annotated onto your 
snapshot. These elements are enabled only when the 
Text Tool button  is selected.

Useful Links “Report Annotation” on page 40

GUI Element (A–Z) Description

Click to save the snapshot on your local machine.

Note: 

➤ The snapshot is saved in .png format.

➤ You cannot select the New Folder icon  when 
saving in the My Documents directory or any of its 
subdirectories. 

Click to select all of the annotations added to your 
snapshot.

Click to clear all annotations.

Click to undo the most recent action performed on the 
snapshot.

Click to redo the most recent action performed on the 
snapshot.

Click to bring the snapshot view closer.
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Click to set the snapshot view further away.

Click to restore the snapshot to its original size.

Click to print the snapshot.

Click to send the snapshot via email.

Click to upload the snapshot to the Report Repository. 
For details on the Report Repository, see “Report Manager 
Overview” on page 90. 

Note: This option is not available when accessing the 
Annotation Tool from the SiteScope feature.

Click for help.

Click to mark the text as bold. 

Note: This field is enabled only when selecting the Text 
Tool button . 

Click to mark the text as italicized. 

Note: This field is enabled only when selecting the Text 
Tool button . 

Click to mark the text as underlined. 

Note: This field is enabled only when selecting the Text 
Tool button . 

Anti-aliasing Select to make adjust the pixel reading of text or 
annotation lines so that they appear smoother. 

Note: This field is only enabled when selecting the Text 
Tool button . 

GUI Element (A–Z) Description
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Common Report Elements

<Font Family> Select the font for the text in the report.

Note: This field is only enabled when selecting the Text 
Tool button . 

<Font Size> Select the size of the font in the report. 

Note: This field is only enabled when selecting the Text 
Tool button . 

Description The options that are common to most report pages.

Important 
Information

➤ You may see only a few of the items described below in 
your report. Report elements specific to a certain 
application are described within that application’s 
documentation.

➤ Reports contain a collapsible report filter which 
includes the specified elements noted in the 
description cells below. Many of these elements appear 
in other reports as well. Click the minimize  or 
restore  button to collapse or expand the report 
filter, respectively.

➤ Many of the elements listed in the Format Options 
table are also available on the report screen of 
HP Business Availability Center legacy reports. For a 
list of HP Business Availability Center legacy reports, 
see “Legacy Reports” on page 33.

Note: When the collapsible report filter is hidden, the 
filter information is visible via a tooltip that appears 
when hovering anywhere on the report title bar.

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

After you have specified the report criteria, click 
Generate to generate the report (in certain 
applications, such as Business Availability Center 
for Siebel Applications, reports are generated 
automatically when the page is loaded).

Certain reports are initially generated 
automatically, whereas for others you must specify 
report criteria and generate the report manually. 
For details on setting reports to be automatically 
generated, see “Configure Report Generation 
Settings” on page 76.

<Time Range and 
Granularity Bar>

Located at the top of the report area. Displays the 
currently selected report date, time frame, and 
granularity. For details, see “Time Range and 
Granularity Bar” on page 66.

Note: This element is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
see “Legacy Reports” on page 33.

Click to send the report via email. For details, see 
“Mail Details Dialog Box” on page 59. 

Note. This button is accessible as a sub-option of 
the Export button , and on the report interface 
for legacy reports. For a list of legacy reports, see 
“Legacy Reports” on page 33. 

Divides a table of data or a list of reports into pages. 
You move from page to page by clicking the 
relevant button:

➤ To view more reports, click the Next page or 
Last page buttons.

➤ To view previous reports in the list, click the 
Previous page or First page buttons.



Chapter 2 • Working in Reports

53

➤ Click the left arrow to adjust the time range of 
the report backwards according to the 
granularity displayed in the View dropdown. 

➤ Click the right arrow to adjust the time range of 
the report ahead, according to the granularity 
displayed in the View dropdown.

Click the Sort Up button to display an alphabetical 
list in the column you chose.

Click the Sort Down button to display a reverse 
alphabetical list in the column you chose. 

Click to reset the table columns’ width to its 
default setting. You can adjust the width of the 
table’s columns by dragging the borders of the 
column to the right or the left.

Click the Select Columns button to open the Select 
Columns dialog box and select the columns you 
want to be displayed on the table. 

For details on the Select Columns dialog box, see 
“Working with Tables” in Reference Information.  

Click the Format button to drill down for options 
on formatting your report. You can then save the 
report to your local machine. For details on format 
options, see “Format Options” on page 56.

Note: Many of format options are available as 
individual buttons on HP Business Availability 
Center legacy reports. For a list of HP Business 
Availability Center legacy reports, see “Legacy 
Reports” on page 33. 

GUI Element (A–Z) Description
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Click the Export button to drill down for options 
on exporting your report. For details on export 
options, see “Export Options” on page 58.

Note: The Export button is not available in 
HP Business Availability Center legacy reports. For 
a list of HP Business Availability Center legacy 
reports, see “Legacy Reports” on page 33.

Click the Capture result and add annotations 
button to capture the report and add annotations. 
For details on annotating reports, see “Report 
Annotation” on page 40. 

Note: This element is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
see “Legacy Reports” on page 33.

Click the Save Filter button to open the Save Filter 
to Favorites dialog box and configure the current 
filter as a favorite filter. For details on Favorite 
Filters, see “Save Filter to Favorites Dialog Box” on 
page 65. 

Note: This element is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
see “Legacy Reports” on page 33.

<breadcrumbs> The list of pages appearing horizontally across the 
top of the page that you have navigated through to 
get to the current page. 

Note: Each page in the list of breadcrumbs is a link 
which you can click to trace your path of 
navigation.

GUI Element (A–Z) Description
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<color coding> HP Business Availability Center uses color coding 
in reports to organize data in a meaningful way, 
and make reports more readable.

Use the legend that appears in a report to get a 
basic description of the color coding used in the 
report. For detailed information about a specific 
report and how to interpret the color coding used, 
refer to that report’s documentation.

Profile Click the link to select the profile to be monitored 
by the report.

Note: This element is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
“Legacy Reports” on page 33.

View as Graph tab Click to display a graphical representation of the 
data. This is generally the default view.

View as Table tab Click to display a tabular representation of the 
data.

GUI Element (A–Z) Description
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Format Options

The following formatting options are available when clicking the Format 
button.

Description Enables you to format the report in a specific format to 
be saved on your local machine. 

To access: Click the Format button  on the right 
side of the report page. 

Important 
Information

On HP Business Availability Center legacy reports, the 
Format options are available as individual buttons on the 
right side of the page. For a list of HP Business 
Availability Center legacy reports, see “Legacy Reports” 
on page 33. 

Useful Links “Common Report Elements” on page 51

GUI Element (A-Z) Description

Click to send a report to a printer. 

Tip: Before printing, ensure that printer settings are set to 
print the selected frame, and not to print frames as laid 
out on screen. 

To obtain optimal print results if you are using Microsoft 
Internet Explorer, enable the Print background color and 
images option (Tools > Internet Options > Advanced tab 
> Printing). 

Click to produce a .pdf format file. 

Click to produce a .csv format file. 

Note: For the CSV formatted report to display correctly, 
the comma (,) must be defined as the list separator. In 
Windows, to verify or modify the list separator value, 
open Regional Options from the Control Panel, and on 
the Numbers tab ensure that the comma is defined as the 
List Separator value. In Solaris, you can specify the list 
separator in the application that opens the CSV file. 
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Click to produce an Excel format file. 

Note: You cannot export information from charts into 
Microsoft Excel.

Click to produce an .xml format file. 

Note: Only those reports that support this functionality 
include the XML button.

GUI Element (A-Z) Description
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Export Options

The following exporting options are available when clicking the Export 
button:

Description Enables you to export a report or report item, either by 
sending it via email, publishing it, or creating a PDF to be 
sent to the Report Manager. 

To access: Click the Export button  on the right side 
of the report page. 

Important 
Information

Export options are not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
“Legacy Reports” on page 33. 

Useful Links “Common Report Elements” on page 51

GUI Element (A-Z) Description

Click to send a report via email. For details, see “Mail 
Details Dialog Box” on page 59. 

Note: The email button is also available on the report 
screen of HP Business Availability Center legacy reports. 
For a list of HP Business Availability Center legacy 
reports, see “Legacy Reports” on page 33. 

Click to publish a report with updated data. For details, 
see “Publish Report Dialog Box” on page 61. 

Note. The Publish button is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
“Legacy Reports” on page 33.

Click to create a PDF of the report and export it to the 
Report Manager. For details on the Report Manager, see 
“Report Manager” on page 89.

Note. The Report Manager button is not available in 
HP Business Availability Center legacy reports. For a list 
of HP Business Availability Center legacy reports, see 
“Legacy Reports” on page 33.
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Mail Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to configure a report to be sent via email. 

To access: Click the Export button  and select Email. 

Important 
Information

If you choose to use a mail option that displays the 
report content in the email client, check that the email 
client does not employ security restrictions which 
prevent the running of scripts contained in HTML mail. 
Email clients that do employ such restrictions may be 
unable to properly display all report content.

Included in Tasks “Working in Reports User Interface” on page 44

Useful Links “Export Options” on page 58

GUI Element (A-Z) Description

Comments Enter relevant comments, if required. 

Include Images Select to include all report resources (for example, 
graphics) in the email.

Clear to remove images from the email. The images are 
then located on HP Business Availability Center servers. 
A network connection to HP Business Availability Center 
is required to access HP Business Availability Center 
servers and view the report images.

Reply to Reply-to. Enter an email address for receiving replies.

Note: If required, an email address can be configured to 
appear in the Reply-to field by default. This is done in the 
Infrastructure Settings Manager. Select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, click 
Foundations, select Business Availability Center, and 
locate the Default Reply-To Address entry in the Business 
Availability Center Interface - Display table. Update the 
value as required.
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Send as Internet 
Explorer Archived 
HTML (.mht)

All report resources (for example, graphics) are displayed 
in the browser, which must support MHT format (such as 
Microsoft Internet Explorer). It is not necessary to have a 
connection to an HP Business Availability Center 
machine to enable you to view the attachment.

Send Report As Specify the format in which you want to send the report. 
Choose from the following options:

➤ HTML mail. The report is displayed in the email client 
(the email client must support, and be configured to 
display, HTML)

➤ HTML attachment. The report is displayed in HTML 
format in a browser. 

Note: You must have a connection to an HP Business 
Availability Center machine to enable you to view the 
attachment. 

➤ PDF. The report is displayed in .pdf format in a new 
browser window. 

Subject Enter a descriptive subject, or accept the default value.

To Enter an email address to whom you want to send the 
report.

Zipped Attachment Select to send the attachment in zipped format. 

Note: This field is available only when HTML attachment 
or PDF have been selected in the Send Report As field. 

GUI Element (A-Z) Description
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Publish Report Dialog Box

Description Enables you to publish HP Business Availability Center 
reports in different formats for other users to view. 

To access: Click the Export button  on the right side 
of the report page, and select Publish Report . 

Important 
Information

➤ To extract HTML code from the published report, 
choose the XML format and click Generate URL or 
Generate HTML. Continue with the relevant 
procedure to publish the report. Click Open to display 
the report in HTML markup in a browser. Save the file 
as HTML, open the file in an HTML editor, and copy 
the relevant table into the target file. 

➤ The log in and log out steps to view the report are 
transparent to the user.

Included in Tasks “Working in Reports User Interface” on page 44

Useful Links “Publishing a Report” on page 39
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Choose export 
format

Choose the export format for the report. The available 
options are: 

➤ CSV. The report is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted report to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that 
the comma is defined as the List Separator value. In 
Solaris, you can specify the list separator in the 
application that opens the CSV file.

➤ Excel. The report is formatted as an .xls (Excel) file that 
can be displayed in a spreadsheet.

Note: Any tooltips in the report are converted to 
comments in Microsoft Excel. To view all the text of a 
large tooltip, edit the comment by right-clicking the 
cell and choosing Edit Comment. Enlarge the box by 
dragging a corner of the comment box. 

➤ XML. The report is formatted as an XML file that can 
be opened in a text or XML editor. 

Tip: To extract HTML code from the report, save the 
file as HTML, open the file in an HTML editor, and 
copy the relevant table into the target file. 

➤ Printer-Friendly. The report is saved in HTML format 
for printing purposes.
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Generate HTML Click to send the report as an HTML file. You can open or 
save the file on your local machine. 

Notes:

➤ The user name and password are encrypted in the 
HTML file.

➤ If you include your own user name and password in 
the HTML file, when the user closes the report, you are 
simultaneously logged out of HP Business Availability 
Center. 

Generate URL Click to generate the URL and displays it in the resulting 
Published URL window. 

Click Copy to select the URL, then paste the URL into an 
email to send to the user. 

Notes: 

➤ It is recommended that the URL not exceed a 
maximum length of 2,000 characters (~2K), to ensure 
that the URL can be read by all systems.

➤ Do not modify the URL string. If necessary, make 
changes to the report itself, then publish the report 
again.

➤ The user name and password are encrypted in the URL 
file.

➤ If you include your own user name and password in 
the URL, when the user closes the report, you are 
simultaneously logged out of HP Business Availability 
Center. 

GUI Element (A-Z) Description
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Save as PDF to Report Manager Dialog Box

Login name 
transmitted with 
report

The login name by which the report recipient can login 
to HP Business Availability Center and view the report. 

Notes: 

➤ The default login name is that with which you logged 
in to HP Business Availability Center in the current 
session.

➤ Do not publish the report with administrator 
permissions. We recommend that you create a login 
name and password for the user with less permissions 
than for an administrator. For details, see “User 
Management – Overview” in Platform Administration. 

Password 
transmitted with 
report

The password by which the report recipient can login to 
HP Business Availability Center and view the report. 

Notes: 

➤ The default password is that with which you logged in 
to HP Business Availability Center in the current 
session.

➤ Do not publish the report with administrator 
permissions. We recommend that you create a login 
name and password for the user with less permissions 
than for an administrator. For details, see “User 
Management – Overview” in Platform Administration. 

Description Enables you to configure parameters of the report you 
want to save as a PDF to the Report Manager. 

To access: Click the Export button  and select Save as 
PDF . 

Included in Tasks “Working in Reports User Interface” on page 44

Useful Links “Report Manager” on page 89

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Save Filter to Favorites Dialog Box

GUI Element (A-Z) Description

<report snapshot> A snapshot of the selected report, as it currently appears.

Description Optionally, enter a description for the report.

Report name Enter a name for the report, to be displayed in the Report 
Manager.

Save report as Choose the privilege level of the report, as per the 
following options: 

➤ Private. The report or report object is available only to 
the user who configured it or an administrator.

➤ Public. The report or report object is available to 
administrators or any user with appropriate 
permissions.

Description Enables you to save the current filter to your list of 
Favorite Filters, to be used for generating a new instance 
of the same report type for which you created the filter.

To access: Click the Save Filter button  on the right 
side of the report page.

Important 
Information

You can view saved filters by selecting the specific filter 
in the Favorite Filters drop-down window.

Included in Tasks “Generate Reports” on page 41

Useful Links “Generating Reports” on page 37
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The following elements are included:

Time Range and Granularity Bar

GUI Element (A–Z) Description

Report Name The name of the report for which you are creating a 
favorite filter. 

Note: This field cannot be edited. 

Filter Name Enter a descriptive name for the filter you are creating.

Filter Description Enter a description for the filter you are creating. The 
description appears only in list of Favorite Filters in the 
Report Repository Manager. 

Save Report As Choose the access level you want to save your report as.

➤ Private. Only the report organizer can view the report 
generated by the filter.

➤ Public. All users with appropriate permission levels can 
view the report generated by the filter.

Description Displays the time range and granularity for which the 
report is generated.

To access: Access the top portion of the report screen, or 
click the restore button  at the top of reports to open 
the collapsible filter pane.

Important 
Information

The time range and granularity bar is not available in 
HP Business Availability Center legacy reports. For a list 
of HP Business Availability Center legacy reports, see 
“Legacy Reports” on page 33.

For reports that are divided by time units, you select a 
report granularity or accept the default granularity. From 
the granularity value and granularity unit lists (labeled 
Every), you select the granularity for the report.

Not all time ranges are available for all reports.
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The following elements are included:

Included in Tasks “Report Annotation” on page 40

Useful Links “Generating Reports” on page 37

GUI Element (A–Z) Description

Click to view the report one time frame earlier than the 
currently displayed time frame. 

Tooltip: Back

Example: If the value of the View field is Day, clicking 
this button displays data for one day earlier than the 
currently displayed report.

Click to view the report one time frame later than the 
currently displayed time frame. 

Tooltip: Forward

Example: If the value of the View field is Day, clicking 
this button displays data for one day later than the 
currently displayed report.

Every Select the report granularity level, or the time frame 
indicating the frequency of how often you want the 
report to be generated. Depending on the time range 
selected in the View field, the following options may be 
available:

➤ Hour

➤ Day

➤ Week

➤ Month

From Click the link to configure a start date and time for the 
report.
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Troubleshooting and Limitations

Following are troubleshooting and limitations relating to various areas of 
Working in Reports:

Annotating a Report

You cannot select the New Folder icon  when saving in the My 
Documents directory or any of its subdirectories.

Formatting a Report

➤ When exporting a report to Microsoft Excel, if you are using Microsoft Excel 
2007, an error message is generated. Click OK to close the error message 
window and display the data in Microsoft Excel. 

➤ You cannot export information from charts into Microsoft Excel.

To Click the link to configure an end date and time for the 
report.

View Select a time range for which you want to view the 
report. Available time ranges include the following 
ranges:

➤ Past hour, Past day, Past week, Past month, Past 
quarter, Past year

➤ Hour, Day, Week, Month, Quarter, Year

➤ Custom (a user defined time period)

Note: The available granularity units (minute, hour, day, 
week, month, year) differ depending on the selected time 
range and the specific report, and the granularity values 
differ per granularity unit.

GUI Element (A–Z) Description
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Generating a Report

If you configure a report with a time range that does not end in the present 
(for example, two days ago, three days ago, two days from now, three days 
from now), when you click Generate to generate the report, the report time 
range remains as it was originally configured and does not update itself to 
end in the present. 

Viewing a Report

If you are having trouble viewing a specific report, you may require Flash 
player to properly view the report. Install Flash player on your machine, and 
then try accessing the report again. For details on viewing reports with 
Adobe Flash player, see “Viewing Reports with Adobe Flash Player” on 
page 40. 

Publishing a Report

When producing a hierarchal UCMDB report, the size of the .pdf is limited 
to the default number of data units defined for your environment. The 
default value is 400. A data unit is the information displayed under a CI in a 
report. In a table, each row is counted as one data unit. If this value does not 
suit your needs and must be modified, contact HP Software Support. 

If the file you are producing contains more than the allotted number of data 
units, the .pdf file is truncated.

The affected UCMDB reports are: 

➤ System Report. For details, see “System Report Page” in Model Management.

➤ Asset Report. For details, see “Asset Report Page” in Model Management.

➤ Related CI’s Report. For details, see “Get Related CIs Report” in Model 
Management.

➤ Correlation Report. For details, see “Correlation Manager Window” in Model 
Management.

➤ Export to Report. For details, see “Package Manager Window” in Model 
Management.
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3
Customizing Reports

This chapter describes how to generate reports automatically or manually, 
and how to specify a header and a footer for a report.

This chapter includes:

Concepts

 ➤  Customizing Reports - Overview on page 71

 ➤  Configuring a Report Header and Footer on page 72

Tasks

 ➤  Customize Report Settings in the Infrastructure Settings Manager on page 74
Concepts

Customizing Reports - Overview

You can specify various settings in the HP Business Availability Center 
Infrastructure Settings manager to enable you to customize the look and 
display of your HP Business Availability Center reports. 

HP Business Availability Center enables you to choose from the following 
customizing options:

➤ Specify a header and a footer for reports. For details, see “Configuring a 
Report Header and Footer” on page 72.

➤ Specify the default browser. For details, see “Specify the Default Browser” on 
page 74.

➤ Generate reports automatically. For details, see “Configure Report 
Generation Settings” on page 76.
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➤ Customize the display of global reports. For details, see “Customize the 
Global Reports Display” on page 77.

➤ Configure the maximum number of data units exportable to .pdf. For 
details, see “Configure the Maximum Number of Data Units Exportable to 
PDF” on page 77.

➤ Configure the maximum number of rows per table. For details, see 
“Configure the Maximum Number of Rows Per Table” on page 78.

➤ customize the display of specific reports. For details, see “Customize the 
Specific Reports Display” on page 78.

Note: HP Business Availability Center also enables you to customize the 
look and layout of specific reports (customizable reports). Contact HP 
Software Support to assist you in performing this type of report 
customization.

Configuring a Report Header and Footer

You can add a header and a footer to a report. You can also modify an 
existing header and footer or return to the default header and footer (blank).

You can add a header or footer in one of the following ways: 

➤ Configure a global report header and footer in the Infrastructure Settings 
Manager. 

The global report header and footer has the following characteristics:

➤ The text of the header/footer has to be valid HTML.

➤ The changes take effect immediately.

➤ The change is applied to all the customizable reports.

➤ The header/footer is static. It remains displayed on the page while you 
scroll the report lines.
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For example, if you specify the header <b>Today’s Results</b>, the header 
appears with a bold font.

As another example, if you specify the footer <center>Per User</center> the 
report shows the footer aligned to the center of the report.

For details on configuring a global header and footer, see “Configure the 
Global Report Header and Footer” on page 75.

➤ Configure a default header and footer for all custom and trend reports in the 
Report Manager. For details, see “Default Header/Footer Dialog Box” on 
page 106.

➤ Configure a header and footer for a specific user report via the selected 
report wizard in the Report Manager. For details, see “Header/Footer Page” 
on page 149 (for Custom Reports), or “Header/Footer Page” on page 184 (for 
Trend Reports).

The report header and footer you add for the specific user report in the 
appropriate wizard overrides the default header and footer configured for all 
custom and trend reports in the Report Manager. The default header and 
footer configured for all custom and trend reports via the Set default header 
/ footer for Custom & Trend reports button in the Report Manager overrides 
the global report header and footer configured in the Infrastructure Settings 
Manager. 

Tasks
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Customize Report Settings in the Infrastructure Settings 
Manager

You can perform the following report customization settings in the 
Infrastructure Settings Manager:

➤ Specify the Default Browser. For details, see “Specify the Default Browser” 
on page 74.

➤ Configure the Global Report Header and Footer. For details, see “Configure 
the Global Report Header and Footer” on page 75.

➤ Configure Report Generation Settings. For details, see “Configure Report 
Generation Settings” on page 76.

➤ Customize the Global Reports Display. For details, see “Customize the 
Global Reports Display” on page 77.

➤ Configure the Maximum Number of Data Units Exportable to PDF. For 
details, see “Configure the Maximum Number of Data Units Exportable to 
PDF” on page 77.

➤ Configure the Maximum Number of Rows Per Table. For details, see 
“Configure the Maximum Number of Rows Per Table” on page 78.

➤ Customize the Specific Reports Display. For details, see “Customize the 
Specific Reports Display” on page 78.

Specify the Default Browser
You can specify the default browser to view reports in. 

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting-Display area.

 3 Click the Edit button next to the Default Browser setting to open the 
Default Browser dialog box.
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 4 Set the Value field as required:

➤ select true to enable Internet Explorer

➤ select false to enable another browser

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.

Configure the Global Report Header and Footer
You can configure the global header and footer that appears for all reports.

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 To specify a header:

➤ Click the Edit button next to the Display static report header setting to 
open the Display static report header dialog box.

➤ In the Value box, enter the text of the header.

➤ Click Save to save the changes.

To restore default settings, click the Restore Default button.

 4 To specify a footer:

➤ Click the Edit button next to the Display static report footer setting to 
open the Display static report footer dialog box.

➤ In the Value box, enter the text of the footer.

➤ Click Save to save the changes.

To restore default settings, click the Restore Default button.

Note: The header and footer configured either via the Set default header / 
footer for all Custom & Trend reports button or via a User Report wizard in 
the Report Manager overrides the global report header and footer. 
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Configure Report Generation Settings
You can configure HP Business Availability Center to generate reports 
automatically after selecting the report from the menu or to generate reports 
only on demand from within the report. 

To configure these settings, users with appropriate administrative privileges 
should perform the changes described in the procedure below.

Note: You must log in again for the changes to take effect.

To configure report generation settings for reports:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting-Display area.

 3 Click the Edit button next to the Generate reports automatically setting to 
open the Generate Reports Automatically dialog box.

 4 Set the property value as required:

➤ select true to enable automatic report generation

➤ select false to disable automatic report generation

 5 Click Save.

To remove automatic report generation, set the property back to false.

To restore default settings, click the Restore Default button.
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Customize the Global Reports Display
You can customize the appearance of your reports by configuring display 
elements to be applied to all reports.

To customize the global display for reports:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 Click the Edit button next to the Global reports display customization 
setting to open the Global reports display customization dialog box.

 4 Enter the XML script in the Value field for the report components you want 
to customize. A sample configuration file is located at: 

<HP Business Availability Center root 
directory>\HPBAC\AppServer\webapps\site.war\WEB-
INF\rfw\conf\internal\rfw-presentation.xml

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.

Configure the Maximum Number of Data Units 
Exportable to PDF
You can configure the maximum number of data units that can be 
presented when exporting hierarchic reports in .pdf format. 

To configure the maximum amount of data units exportable to .pdf:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 Click the Edit button next to the Maximum number of data units exportable 
to .pdf setting to open the Maximum number of data units exportable to 
.pdf dialog box.
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 4 Enter the number of data units you want to set as the maximum number 
exportable to a hierarchic .pdf report in the Value field.

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.

Configure the Maximum Number of Rows Per Table
You can configure the maximum number of rows that are presented when 
generating a table in a report.

To configure the maximum number of rows per table:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 Click the Edit button next to the Maximum number of rows per table 
setting to open the Maximum number of rows per table dialog box.

 4 Enter the maximum number of rows in the Value field you want displayed 
in the table. 

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.

Customize the Specific Reports Display
You can customize the appearance of your reports by configuring display 
elements to be applied to specific reports. 

To customize the display for specific reports:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 Click the Edit button next to the Specific report display customization 
setting to open the Specific reports display customization dialog box.
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 4 Enter the XML script in the Value field for the report components you want 
to customize. A sample configuration file is located at: 

<HP Business Availability Center root 
directory>\HPBAC\AppServer\webapps\site.war\WEB-
INF\rfw\conf\applications\*-presentation.xml

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.
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4
Reports Log

HP Business Availability Center logs all activities related to reports as well as 
errors that occur when generating reports. Such activities include: creating a 
new report, generating a report, modifying report filters, drilling down in 
reports, and so forth. 

This chapter includes:

Concepts

 ➤  Reports Log - Overview on page 81

 ➤  Reports Log Level on page 83

Tasks

 ➤  Set the Reports Log Level on page 84

Reference

 ➤  Reports Log Structure on page 84

Concepts

Reports Log - Overview

HP Business Availability Center records all activities related to specific 
reports in a reports log. The activities that are logged are: 

➤ Errors. For details, see “Logging Errors” on page 82.

➤ Any other activity performed on the report. For details, see “Logging 
Activities” on page 82.
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The reports log records activities for all HP Business Availability Center 
reports, except for legacy reports. For a list of available HP Business 
Availability Center reports, including legacy reports, see “Legacy Reports” 
on page 33.

The reports log is located at HPBAC\log\EJBContainer\reports.log.

Each error and activity is recorded using a specific format – for details about 
the reports log format, see “Reports Log Structure” on page 84.

Logging Errors

Logging occurs for any error during:

➤ report initialization

➤ report customization – for details on customizing reports, see “Customizing 
Reports” on page 71

➤ report rendering (creating the report display)

Logging Activities

Logging occurs for any action related to reports. The actions that are logged 
are: 

➤ creating a new report

➤ generating a report

➤ updating the filter of a report that is included in a custom report

➤ drilling down in a report and between reports

➤ updating the filter of a report

➤ printing a generated report, exporting it using email, or opening it in 
Microsoft Excel file format or in PDF format. For details on these actions, see 
“Format Options” on page 56.
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Reports Log Level

Depending on the log level you specify, the following information can be 
recorded in the reports log: 

➤ debugging information

➤ activities performed on reports

➤ warning messages

➤ error messages

➤ fatal errors

The log levels have the following hierarchy: DEBUG, INFO, WARN, ERROR, 
and FATAL, where DEBUG represents the lowest level and FATAL the highest 
level. The default level is ERROR.

The log level hierarchy means that if you select one of the levels, the report 
includes all the information related to that level and the levels above it, as 
follows:

Tasks

Level Reports log 

DEBUG Includes debugging information, activities 
performed on reports, warning messages, error 
messages, and fatal errors.

INFO Includes activities performed on reports, warning 
messages, error messages, and fatal errors.

WARN Includes warning messages, error messages, and 
fatal errors.

ERROR Includes error messages, and fatal errors.

FATAL Includes fatal errors.
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Set the Reports Log Level

You set the Reports log level to record the reports information that you want 
to track.

To set the Reports Log level:

 1 Open the HPBAC\conf\core\Tools\log4j\EJB\topaz.properties file with a 
text editor.

 2 Search for the following line: 
log4j.category.com.mercury.am.bac.core.reports= ${<loglevel>}, 
reports.appender

 3 Change <loglevel> to DEBUG, INFO, WARN, ERROR, or FATAL. 

 4 Save the file.
Reference

Reports Log Structure

The reports log includes entries for each activity or error. Each entry has the 
following structure:

 

2005-08-24 11:25:07,590 [TP-Processor1] (NewReportAction.java:66) <loglevel> - 
MERQ-120238: USER ACTION started
----------------------------------------=----------------------------------------
Action= <action>
User= <user> (id:<id>)
Report ID= <report_id>;  State ID: <state_id>
----------------------------------------=----------------------------------------
2005-08-24 11:25:15,980 [TP-Processor1] (DisplayAction.java:77) <loglevel> - MERQ-
120242: USER ACTION ended
----------------------------------------=----------------------------------------
User= <user> (id:<id>)
Report ID= <report_id>;  State ID: <state_id>
Duration=    <duration> ms  (init:6141;  render:3859)
Time filter=  View: <view>; From:<from_day_time>; To: <to_day_time>; Every: 
<periodicity>
----------------------------------------=---------------------------------------- 
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where:

➤ <log_level> represents the level that you selected – for details about the log 
level, see “Set the Reports Log Level” on page 84.

➤ <action> is the type of activity that has been logged:

➤ New report. The user created a new report from a menu.

➤ Generate. The user clicked the Generate button.

➤ CustomSaveFilter. The user clicked OK in the filter of new reports when 
creating a custom report.

➤ Update filter. The user modified the filter in one of the reports.

➤ Navigate. The user drilled down in a report or between reports.

➤ Export. The user exported a report to Excel, .PDF, .CSV, or e-mail formats.

➤ <user> is the login name.

➤ <id> is for internal use.

➤ <report_id> is the report requested by the user action.

➤ <state_id> is for internal use.

➤ <duration> is the number of milliseconds the server took to perform the 
user action.

➤ The time filter that was used in the activity includes the following 
information:

➤ <view> indicates the filter that was selected. This information is for 
internal use.

➤ <from_day_time> indicates when the activity started. This information is 
for internal use.

➤ <to_day_time> indicates when the activity ended.

➤ <periodicity> indicates the sampling periodicity. This information is for 
internal use.
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For example, the following entry specifies that a new report CMDBOverTime 
has been created by the admin user: 



Part II

User Reports
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5
Report Manager

This chapter includes the main concepts, tasks, and reference information 
for the Report Manager.

This chapter includes:

Concepts

 ➤  Report Manager Overview on page 90

 ➤  Saving a Report as a PDF to the Report Manager on page 91

 ➤  Favorite Filters on page 91

 ➤  Report Schedules on page 92

 ➤  Excel Reports on page 92

Tasks

 ➤  Work With the Report Manager - Workflow on page 93

 ➤  Create a Schedule on page 101

Reference

 ➤  Report Manager User Interface on page 102

Troubleshooting and Limitations on page 121
Concepts
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Report Manager Overview

The Report Manager is a central location where you can manage selected 
reports and report objects from throughout HP Business Availability Center. 
The Report Manager enables you to create and manage the following:

➤ Favorite Filters. You can create a Favorite Filter to be used to regenerate a 
report with predefined filters. For details, see “Favorite Filters” on page 91.

➤ Custom Reports. You can create custom reports consisting of selected 
components (individual application reports) that enable you to focus on the 
data you are most interested in tracking. For details, see “Custom Reports” 
on page 123. 

➤ Trend Reports. You can create a report which enables you to compare 
multiple measurements from several profiles collected by Business Process 
Monitor, Real User Monitor, and SiteScope. This enables you to analyze how 
various internal HP Business Availability Center factors affect system 
performance. For details, see “Trend Reports” on page 171.

➤ Service Reports. You can create a report based on data from data sources 
from the Service Level Management, Dashboard, or other applications. For 
details, see “Service Report” in Using My BAC. 

➤ Schedules. You can create a schedule for a report or report object to be sent 
to specified individuals at set times. For details, see “Report Schedules” on 
page 92.

➤ Custom Links. You can create a link to open a web page in a browser 
window. For details, see “New Custom Link Page” on page 119.

➤ Excel Reports. You can build and view customized reports in HP Business 
Availability Center that take advantage of the charting abilities of Microsoft 
Excel. For details, see “Excel Reports” on page 92.

➤ Annotations. You can create a snapshot of selected reports and highlight 
important areas of the report by drawing shapes, lines, and adding text to 
the snapshot. For details, see “Report Annotation” on page 40.
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➤ Email. You can send reports and report objects to selected individuals via 
email. For details, see “Email Dialog Box” on page 107.

➤ PDF. You can store a PDF of selected HP Business Availability Center reports, 
to access at a later time. For details, see “Saving a Report as a PDF to the 
Report Manager” on page 91.

Saving a Report as a PDF to the Report Manager

You can save the data of selected reports to the Report Manager, for viewing 
on other occasions, or for sending to other users. Reports are stored as PDF 
files in the Report Manager, and the report is saved with data valid at the 
time the report is saved. This is the case even if data subsequently changes, 
or more data accrues to the report. 

You can save all reports to the Report Manager, except for HP Business 
Availability Center Legacy Reports. For a list of HP Business Availability 
Center Legacy Reports, see “Legacy Reports” on page 33. 

Favorite Filters

Favorite Filters enable you to save a report filter and reuse it for future 
generating of the report. The filter you create can be used only for the same 
report which it was created for. Filters include the time range and 
granularity for which the report is generated, as well as profiles, active 
filters, configuration items (CIs) and Key Performance Indicators (KPIs) 
configured for the report. For details on creating a Favorite Filter, see 
“Favorite Filters Wizard” on page 114.
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Report Schedules

You configure schedules to enable specified recipients to automatically 
receive reports, via e-mail, at regularly defined intervals. 

You can schedule Favorite Filters, Custom Reports, Trend Reports, and 
Service Reports defined in the Report Manager. To do so, you must have 
View permissions for the Recipients resource and Add permissions for the 
Scheduled Reports resource. For details on assigning user permissions, see 
“Assign Permissions” in Platform Administration.

For details on configuring report schedules, see “Create a Schedule” on 
page 101.

Administrators can manage configured report schedules via the Scheduled 
Reports tab, located at Admin > Platform > Report Schedule Manager. For 
details on managing report schedules via the Scheduled Reports tab, see 
“Report Schedule Manager” in Platform Administration.

Excel Reports

You can build and view customized reports in HP Business Availability 
Center that take advantage of the charting abilities of Microsoft Excel, to 
display various types of data collected by HP Business Availability Center 
data collectors. The reports can be viewed with Microsoft Excel or any 
spreadsheet program capable of reading files with the .xls format. You can 
also upload Excel reports that were created using the .xlsx format. For details 
on creating a Microsoft Excel Report, see “Create a Microsoft Excel Report - 
Workflow” on page 230.

Note: Contact HP Software-as-a-Service Support for details on implementing 
Microsoft Excel reports in HP Software-as-a-Service. 

Tasks
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Work With the Report Manager - Workflow

This task describes how to create, manage, and distribute reports using the 
Report Manager.

For a scenario of this task, see “Work With the Report Manager - Scenario” 
on page 95.

This task includes the following steps:

➤ “Create a Favorite Filter” on page 93

➤ “Create a Custom Report” on page 93

➤ “Create a Trend Report” on page 93

➤ “Create a Service Report” on page 94

➤ “Create a Custom Link” on page 94

➤ “Create an Excel Report” on page 94

➤ “View a User Report” on page 94

➤ “Email a User Report” on page 94

 1 Create a Favorite Filter
You can create a filter for reports, save it and apply it to the specified report. 
For details on creating a Favorite Filter, see “Favorite Filters Wizard” on 
page 114.

 2 Create a Custom Report
You can create a customized report with components that you select to 
present the data most relevant to you. For details on creating a Custom 
Report, see “Custom Reports Wizard” on page 127.

 3 Create a Trend Report
You can configure a report which compares multiple measurements from 
various profiles, enabling you analyze how various internal HP Business 
Availability Center factors affect system performance. For details on creating 
a Trend Report, see “Trend Reports Wizard” on page 173.
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 4 Create a Service Report
You can create a custom report that displays selected data from data sources 
of the Service Level Management, Dashboard, or other applications, using 
the Service Report Wizard in the Report Manager. For details on creating a 
Service Report, see “Configure a Service Report in Report Manager – 
Workflow”in Using My BAC.

 5 Create a Custom Link
You can create a link to open a web page in a browser window. For details 
on creating a Custom Link, see “New Custom Link Page” on page 119.

 6 Create an Excel Report
You can build and view customized reports in HP Business Availability 
Center that take advantage of the charting abilities of Microsoft Excel. For 
details on creating an Excel Report, see “Create a Microsoft Excel Report - 
Workflow” on page 230.

 7 View a User Report
You can view a User Report, PDF, or annotation of an HP Business 
Availability Center report by selecting the report or report object in the 
Report Manager table and clicking the View button on the Report Manager 
Main Page. 

 8 Email a User Report
You can send a Favorite Filter, Custom Report, Trend Report, or Service 
Report to selected users via email. For details, see “Email Dialog Box” on 
page 107.
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Work With the Report Manager - Scenario

This scenario describes how to create, manage, and distribute reports using 
the Report Manager. 

For a task of this scenario, see “Work With the Report Manager - Workflow” 
on page 93.

This scenario includes the following steps:

➤ “Creating a Favorite Filter” on page 95

➤ “Creating a Custom Report” on page 96

➤ “Creating a Trend Report” on page 97

➤ “Creating a Service Report” on page 98

➤ “Creating a Custom Link” on page 99

➤ “Creating an Excel Report” on page 99

➤ “Emailing a User Report” on page 99

➤ “Viewing a Report Saved to the Report Manager” on page 99

 1 Creating a Favorite Filter
John Smith is the CEO for ABC Software Company. He wants to see the data 
output of the Triage Report that is generated each day between 10:00 and 
11:00 AM. He clicks the New button and selects New Favorite Filter. In the 
Favorite Filters Wizard, he configures a Favorite Filter by selecting the profile 
and relevant active filters he wants to view, and configures the Time Range 
and Granularity bar to generate the report data every day between 10:00 and 
11:00 AM. 
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The Favorite Filter appears as follows:

 2 Creating a Custom Report
The information that John most needs to see is the Availability Over Time 
and Response Time Over Time reports, located in the Business Process 
Monitor category. He clicks the New button, selects New Custom Report 
and navigates to the Report Components page where he selects User 
Experience Reports in the Category field, and Availability Over Time and 
Response Time Over Time in the Type field to add these report components 
to his custom report. 
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The Custom Report appears as follows:

 3 Creating a Trend Report
John also wants to receive a daily report comparison of Transaction 
Response Time and Download Time data within Business Process Monitor. 
He clicks the New button, selects New Trend Report and navigates to the 
Select Measurements page and clicks the Add New Component button to 
open the Measurement Selection page, where he adds the relevant selections 
to his Trend Report, as described in “Trend Reports Wizard” on page 173.



Chapter 5 • Report Manager

98

The Trend Report appears as follows:

 4 Creating a Service Report
John wants to view data collected from the Dashboard KPIs data source. He 
clicks the New button, selects New Service Report and configures a Service 
Report, as described in “Configure a Service Report – Scenario” in Using My 
BAC.
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 5 Creating a Custom Link
John creates a link to a select report page by clicking the New button 
selecting New Custom Link, and entering the URL of the report page he 
wants to view. 

 6 Creating an Excel Report
John wants to view his report data in a more organized format, and decides 
to use Microsoft Excel for this purpose. He follows this procedure: 

 a Navigates to the Custom Query Builder and creates a Web Query, as 
described in “Build a Custom Query – Workflow” on page 198.

 b Opens Microsoft Excel and creates a Microsoft Excel report, as described 
in “Reference” on page 201. 

 c John then navigates to the Report Manager, clicks the New button, 
selects New Excel Report and browses to the file he saved. The Excel 
report is saved to the Report Manager.

 7 Emailing a User Report
John wants to send his Custom Report to an associate to show him the data 
that has been collected. He selects his Custom Report in the Report Manager 
and clicks the Email button to choose a recipient from the Email dialog box 
and send the Custom Report via email. 

 8 Viewing a Report Saved to the Report Manager
One of John’s associates has saved an annotated report to the Report 
Manager, and John wants to view the areas in the report that have been 
highlighted by the annotations. He selects the annotation in the Report 
Manager and clicks the View button to view the report’s annotations. 
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The Report Manager page appears as follows: 

The annotated report appears, with annotations indicated by black and 
purple boxes, as follows:
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Create a Schedule

This task describes how to create a scheduled report to enable specific 
recipients to automatically receive reports, via email, at regularly defined 
intervals.

This task includes the following steps:

➤ “Prerequisites” on page 101

➤ “Create a Schedule” on page 101

➤ “Results” on page 101

 1 Prerequisites
Ensure that you have at least one Favorite Filter, Custom Report, Trend 
Report, or Service Report in the Report Manager. For details on configuring 
reports and report objects, see “Work With the Report Manager - Workflow” 
on page 93.

 2 Create a Schedule

 a Click the Create new schedule for selected reports button .

 b Enter the requested information in the Create New Schedule Dialog Box. 
For details on creating a new schedule in the Create New Schedule Dialog 
Box, see “Create New Schedule Dialog Box” on page 110.

 3 Results
The configured schedule’s status is indicated in the Scheduling column of 
the Report Manager. 

Click the link in the Scheduling column to open the Schedule Management 
dialog box and manage the configured schedules. For details, see “Schedule 
Management Dialog Box” on page 113.

Reference
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Report Manager User Interface

This section describes:

 ➤  Report Manager Main Page on page 102

 ➤  Favorite Filters Wizard on page 114

 ➤  New Custom Link Page on page 119

 ➤  New Excel Report Page on page 120

Report Manager Main Page

Description Enables you to manage the contents of the Report 
Manager and perform a variety of actions, including: 

➤ View, edit, and clone existing components. 

➤ Configure new user reports and Favorite Filters.

➤ Email selected reports.

➤ Create a schedule for selected reports to run.

To access: Select Applications > User Reports > Report 
Manager.

Important 
Information

You can filter the contents of the Report Manager by 
entering or selecting values in the cells under each 
column heading.

You can select multiple entities by pressing and holding 
the Ctrl button on your keyboard while making your 
selection. 
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The following elements are included:

GUI Element (A–Z) Description

Click to view the selected report or report object. 

Click to create a new report or report object. Choose from 
the following options:

➤ New Favorite Filter. For details, see “Favorite Filters 
Wizard” on page 114. 

➤ New Custom Report. For details, see “Custom Reports 
Wizard” on page 127.

➤ New Trend Report. For details, see “Trend Reports 
Wizard” on page 173.

➤ New Service Report. For details, see “Service Report 
Builder Wizard” in Using My BAC.

➤ New Custom Link. For details, see “New Custom Link 
Page” on page 119. 

➤ New Excel Report. For details, see “New Excel Report 
Page” on page 120.

Click to edit the selected report or report object. 

Note: Clicking this button opens the selected report or 
report object’s wizard. 

Click to create a copy of the report or report object. You 
can then edit parameters in the wizard of the selected 
report or report object.

Note: Any schedules configured for a specific report or 
report object are not cloned when selecting this option. 

Click to delete the report or report object.

Notes: 

➤ Deleting a report causes all schedules configured for 
the report to also be deleted. 

➤ You can delete multiple selections at once. 

Click to email the selected report or report object. For 
details, see “Email Dialog Box” on page 107.
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Click to create a schedule to send the report to specified 
individuals at specific intervals. For details, see “Create 
New Schedule Dialog Box” on page 110. 

Click to open the Schedule Management dialog box and 
manage schedules configured for the selected report or 
report object. For details, see “Schedule Management 
Dialog Box” on page 113.

A user with Administrator permissions can view and 
manage all schedules for all reports from the Report 
Schedule Manager. For details, see “Report Schedule 
Manager” in Platform Administration. 

Click to delete all schedules from the selected report.

Click to resume all schedules for the selected report

Click to pause all schedules for the selected report. 

Click to configure a default header and footer for all 
custom and trend reports in the Report Manager. For 
details, see “Default Header/Footer Dialog Box” on 
page 106.

Click to refresh the Report Manager page.

Click to reset the width of the columns to the default 
setting. 

Click to select columns to be visible in the table. For 
details, see “Working with Tables” in Reference 
Information.

Description The description of the report or report object as entered 
in the selected configuration wizard. 

Note: This element is not displayed for Custom and 
Trend reports. 

GUI Element (A–Z) Description
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Details Displays information on the report or report object 
according to the selected report type, as follows: 

➤ Favorite Filter. The Name of the Report (value of the 
Report Name field) that the Filter is associated with. 

➤ Custom Report. The titles of the components added to 
the report in the Custom Report Wizard.

➤ Trend Report. The value of the Name field for the 
measurements added to the Trend Report in the Trend 
Report Wizard.

The Details field is empty for Custom Links, Excel 
Reports, and Service Reports.

Name The name of the report or report object.

Owner The user who created the report or report object.

Privilege The privilege level of the report or report object. The 
available values are:

➤ Private. The report or report object is available only to 
the user who configured it, or an administrator.

➤ Public. The report or report object is available to 
administrators or any user with appropriate 
permissions.

Note: This element is not displayed for Custom Reports, 
Trend Reports, and Custom Links, which by default have 
the Public privilege level.

GUI Element (A–Z) Description
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Default Header/Footer Dialog Box

Scheduling Indicates if schedules are configured for the selected 
report or filter, and displays a link to the list of schedules, 
if they exist). 

Click the indicated schedules link to open the Schedules 
Management dialog box and manage schedules for the 
selected item. For details, see “Schedule Management 
Dialog Box” on page 113. 

Note: A user with Administrator permissions can view 
and manage all schedules for all reports from the Report 
Schedule Manager. For details, see “Report Schedule 
Manager” in Platform Administration. 

Type The type of report or report object displayed. 

Description Enables you to create a default header and footer to be 
displayed for all custom and trend reports.

To access: Select Applications > User Reports > Report 
Manager, click the Set default header/footer for all 
Custom & Trend Reports button .

Important 
Information

The header and footer configured in the Default 
Header/Footer Dialog Box overrides the header and 
footer configured in the Infrastructure Settings page.

The Default Header/Footer Box contains the following 
elements:

➤ Header HTML. Enter the header text with valid HTML 
tags. 

➤ Footer HTML. Enter the footer text with valid HTML 
tags.

➤ Preview button. Click to preview the configured 
header and footer. 

GUI Element (A–Z) Description
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Email Dialog Box

Description Enables you to send the selected report or report object 
via email.

To access: Click the Email button  on the Report 
Manager Main Page. 

Important 
Information

➤ You must have View permissions to email a report. 

➤ The email dialog box contains the following sections:

➤ Recipients. Enables you to select recipients to 
receive the email. For details, see “Recipients Pane” 
on page 108.

➤ Report Coverage Time. Enables you to configure 
the time frame to be monitored by the report. For 
details, see “Report Coverage Time Pane” on 
page 108. This field is enabled only when selecting 
a Custom or Trend Report.

➤ You can also configure the following in the email 
dialog box:

➤ Format. Select the format of the report. 

➤ Display report as. Select the format of the report 
attachment. 

➤ Language. Select the language of the report 
attachment. The server from which the schedule is 
being sent must support the selected language for 
the report to display properly. 
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Recipients Pane

The following elements are included:

Report Coverage Time Pane

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Click to move recipients to the Selected Recipients pane. 
You must highlight recipients in the Available Email 
Recipients pane before clicking this button. 

Click to de-select recipients by highlighting and move 
them to the Available Email Recipients pane. You must 
highlight recipients in the Selected Recipients pane 
before clicking this button.

Available Email 
Recipients

The list of configured recipients who are currently not 
selected to receive email on the report or report object. 

New Recipient Click to add a new recipient to receive email of the report 
or report object. For details, see “Recipient Properties 
Wizard” in Alerts.

Selected Recipients The list of configured recipients who are currently 
selected to receive email on the report or report object.

GUI Element (A–Z) Description

Click to move the report coverage time range back the 
time frame specified in the View field. granularity.

Click to move the report coverage time range ahead the 
time frame specified in the View field. 
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<granularity drop 
down>

Select the time range for the report’s data to cover. 
Options are:

➤ Day

➤ Week

➤ Month

➤ Quarter

<time zone drop 
down>

Select the time zone that the report generation time is to 
take effect from. 

From Click to select the start date and time for the generated 
report.

To Click to select the end date and time for the generated 
report. 

View Select the time frame that the emailed report is to cover. 

GUI Element (A–Z) Description
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Create New Schedule Dialog Box

Description Enables you to schedule a report to be sent to specified 
individuals at specific intervals. 

To access: 

➤ Click the Create new schedule for selected reports 
button  on the Report Manager main page.

➤ Click the New button  on the Schedules 
Management dialog box, accessible by clicking the 
listed schedules in the Scheduling column.

Note: This dialog box is also accessible by navigating to 
Admin > Platform > Report Schedule Manager, and 
clicking the Edit Selected Schedule button . For 
details on the Report Schedule Manager, see “Report 
Schedule Manager” in Platform Administration. 

Important 
Information

By default, the value that appears in the From field in the 
e-mail containing the scheduled report is 
HPBAC_Alert_Manager@<HP Business Availability Center 
server name>. You can modify the value by selecting 
Admin > Platform > Setup and Maintenance > 
Infrastructure Settings and the Scheduled Reports 
context in the Foundations tab. Modify the value E-mail 
sender or Scheduled Reports e-mail sender address (to 
include an e-mail address in the From field). For details 
on modifying values, see “Infrastructure Settings 
Manager Page” on page 211.

To correctly view scheduled reports received in Microsoft 
Outlook 2003, in Tools > Options > Security > Zone 
Settings, select Internet; click Custom Level and specify 
the following settings in the Security Settings dialog box: 
Download signed ActiveX control = Prompt, Run ActiveX 
controls and plug-ins = Enable, Script ActiveX controls 
marked safe for scripting = Enable; in the Reset to list, 
select Medium.

Included in Tasks “Create a Schedule” on page 101

Useful Links “Report Schedules” on page 92
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Generate data for 
the past X hours

Select the number of previous hours the report should be 
generated for. 

Note: This option is enabled only when the Daily 
recurrence pattern is selected for Custom and Trend 
reports. 

Range of recurrence Configure the start and end time of the schedule, as 
follows: 

➤ Start. Click to configure the date for the schedule to 
start. 

➤ No end date. Select for the schedule to run 
indefinitely.

➤ End by. Click to configure the date for the schedule to 
end. 

Recipients Configure recipients to receive the report at the 
scheduled time. For details on configuring recipients, see 
“Recipients Pane” on page 108.

Recur every day on Select the days of the week the report is to run.
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124

Recurrence Pattern ➤ For a Favorite Filter and Service Report, enables you to 
select how often the report object is to be sent. 

➤ For a Custom Report and Trend Report, enables you to 
select how often the report object is to be sent and 
enables you to select the time frame for when the 
report data is to be generated. 

You also select the following configurations:

➤ How often the report is to run. Choose from:

➤ Daily 

➤ Weekly

➤ Monthly

➤ Quarterly

➤ Days of the week the report is to run, if you chose 
Daily or Weekly. 

➤ The first or last day of every month or quarter, if you 
chose Monthly or Quarterly.

➤ The specific day of the month or quarter, if you chose 
Monthly or Quarterly.

Report Generation 
Time 

If you chose Use global setting for all reports in the Time 
period section of the Custom Report wizard, you set the 
end time for the report’s data to be collected, and the 
time zone in which the generation should take place. The 
Scheduled Report is then sent to the selected recipients at 
the time specified in this setting. 

Note: If you chose Use separate time period for each 
report in the Time period section of the Custom Report 
wizard, the time you configure here determines only 
when the report is sent out, and does not override the 
report coverage time settings configured in the report 
components’ filter. 

Select Language Select a language for the schedule to be sent in. 

Note: The server from which the schedule is being sent 
must support the selected language for the report to 
display properly.

Time Zone Select a time zone according to whose time the schedule 
is to be sent.

GUI Element (A–Z) Description
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Schedule Management Dialog Box

The following elements are included:

Description Enables you to manage configured schedules. 

To access: 

➤ Click the link in the Scheduling column next to the 
relevant item on the Report Manager Main Page. 

➤ Click the Manage schedules list button  on the 
Report Manager Main Page.

Useful Links “Create New Schedule Dialog Box” on page 110

GUI Element (A–Z) Description

Click to create a new schedule for the selected report or 
report object. For details on creating schedules, see 
“Create New Schedule Dialog Box” on page 110. 

Click to resume the selected schedule according to its 
configured running time.

Click to pause the selected schedule. 

Click to delete the selected schedule. 

Note: Deleting the schedule does not delete the report.

Generation Time The time (in the indicated time zone) that the schedule is 
to be generated. 

Recipients The recipients configured to receive the selected 
schedule.

Recurrence The recurrence pattern for the selected schedule.

Status The current status of the schedule, indicated by an icon.

Tooltip: Indicates the status of the schedule.

Note: If an error status is indicated, see the scheduler log 
located at: 

<HP Business Availability Center root 
directory>\hpbac\log\schedulergw\scheduler.log
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Favorite Filters Wizard

Filter Properties Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a filter to be applied to reports.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New 
Favorite Filter.

Important 
Information

Favorite Filters cannot be applied to specific legacy 
reports. For a list of legacy reports, see “Legacy Reports” 
on page 33.

Included in Tasks “Generate Reports” on page 41

Wizard Map The Favorite Filters wizard contains:

Filter Properties Page > Filter Setting Page > Report 
Preview Page

Description Enables you to choose the report you want to assign a 
Favorite Filter to, and configure the name, description, 
and access level of the filter. 

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New 
Favorite Filter.

Important 
Information

For general information about the Favorite Filters wizard, 
see “Favorite Filters Wizard” on page 114.

Wizard Map The Favorite Filters Wizard contains:

Filter Properties Page > Filter Setting Page > Report 
Preview Page

GUI Element (A–Z) Description

Filter Description Optionally, enter a description for the filter. 

Filter Name Enter a descriptive name for the filter.
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Filter Setting Page

Save Filter As Choose the access level for the favorite filter:

➤ Private. The filter is available only to the user who 
configured it, or to an administrator.

➤ Public. The filter is available to any user with 
appropriate permissions. For details on user 
permissions and the privileges they provide, see “User 
Management Operations” in Platform Administration.

Select report Click to select from the list of reports to assign the 
Favorite Filter to. For details on the reports, “HP Business 
Availability Center Reports” on page 13.

Description Enables you to configure parameters for the filter.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New 
Favorite Filter.

Important 
Information

You must enter information in the Filter Properties page 
to access the Filter Setting page.

General information about the wizard is available in 
“Favorite Filters Wizard” on page 114.

Wizard Map The Favorite Filters Wizard contains:

Filter Properties Page > Filter Setting Page > Report 
Preview Page

GUI Element (A–Z) Description
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The following elements are included:

Configuration Items Dialog Box

GUI Element (A–Z) Description

<filters> The active filters displayed on the Filter Setting page 
depend on the report you have chosen. The various filter 
options are described in the documentation for the 
specific report you are viewing. For a list of all 
HP Business Availability Center reports, see “HP Business 
Availability Center Reports” on page 13.

Time Range and 
Granularity Bar

Choose the date, time frame, and granularity for the 
filter.

For details, see “Time Range and Granularity Bar” on 
page 66.

Description Enables you to select the CIs to be included in the 
report on which you are configuring the Favorite Filter. 

To access: Click the Configuration Items link on the 
Filter Setting page of the Favorite Filter dialog box. 

Important 
Information

➤ The Configuration Items link is available only in for 
selected Dashboard, End User Management, and 
UCMDB reports. 

➤ The availability of the tabs in the Configuration 
Items dialog box depends on the specific report you 
are generating. For details, see the description of the 
specific report that you are working with. 

➤ For details on the elements contained in the 
Configuration Items Dialog Box, see “Configuration 
Items Dialog Box” in Using Dashboard.
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KPIs Dialog Box

Active Filters Dialog Box

Description Enables you to select the KPIs on which to run the 
Favorite Filter, for the duration of a Web session. 

To access: Click KPIs on the Filter Setting page in the 
Favorite Filters wizard.

Important 
Information

➤ The KPIs dialog box is available only in for selected 
Dashboard reports. 

➤ The availability of the tabs in the KPIs dialog box 
depends on the specific report you are generating. 
For details, see the description of the specific report 
that you are working with. 

➤ For details on the elements contained in the KPIs 
Dialog Box, see “KPIs Dialog Box” in Using 
Dashboard.

Description Enables you to set filters on specific report components 
to be included in the Favorite Filter. 

To access: Click the Active Filters link on the Filter 
Setting page in the Favorite Filters Wizard.

Important 
Information

➤ The Active Filters link is available for Real User 
Monitor and Business Process Monitor reports.

➤ The availability of the tabs in the Active Filters dialog 
box depends on the specific report you are generating. 
For details, see the description of the specific report 
that you are working with. 

➤ Active filters are saved across reports. For details, see 
“Active Filters Dialog Box” in Using End User 
Management.
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Applications Dialog Box

Report Preview Page

Description Enables you to select the applications to be included in 
the Favorite Filter.

To access: Click the Applications link on the Filter Setting 
page of the Favorite Filters Wizard.

Important 
Information

➤ The Applications link is available only when a Real 
User Monitor report has been selected on the Filter 
Properties page. 

➤ In the Global Statistics report, you select an 
application from the dropdown list in the Application 
field.

➤ For details on the elements contained in the 
Applications Dialog Box, see “Applications Dialog 
Box” in Using End User Management.

Description Displays a snapshot of the generated report, based on the 
parameters configured for the filter.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New 
Favorite Filter.

Important 
Information

The Report Preview Page only displays the report and 
does not enable any functionality on the report 
snapshot.

Wizard Map The Favorite Filters Wizard contains:

Filter Properties Page > Filter Setting Page > Report 
Preview Page
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New Custom Link Page

Description Enables you to create a custom link to open a web page in 
a browser window.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New 
Custom Link.

Important 
Information

➤ The Custom Link page consists of the following fields:

➤ Name. Enter a descriptive name for the custom link.

➤ URL. Enter the URL of the web page you to which 
you want to create a link. 

To view the linked site, select the Custom Link in the 
Report Manager table, and click the View button . 

➤ When entering the URL, do not enter a URL that is 
redirected. If the link is accessed, a redirection may 
cause a runtime error or the application to log out. 
Enter only URLs that are accessed directly upon 
linking.

➤ If the specified Web page includes JavaScript code that 
attempts to access the top frame, the browser displays 
an “access denied” error. To avoid this issue, set the 
browser to ignore JavaScript errors.
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New Excel Report Page

Description Enables you to upload a Microsoft Excel report that 
includes HP Business Availability Center data to the 
Report Manager. 

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New Excel 
Report.

Important 
Information

➤ Before you can upload an Excel report, you must first 
create a web query file that you then import into 
Excel, as well as creating the report itself in Excel. For 
details, see “Create a Microsoft Excel Report - 
Workflow” on page 230.

➤ The New Excel Report page consists of the following 
fields:

➤ Report name. Type the name for the report as you 
want it to appear in the Report Manager table.

➤ Description. Type the description for the report as 
you want it to appear in the Report Manager table.

➤ Excel file. Type the path to the saved Excel file you 
want to add, or use the Browse function to browse 
to the file. You can add .xls or .xlsx files. 

Included in Tasks “Create a Microsoft Excel Report - Workflow” on 
page 230

“Create a Microsoft Excel Web Query File” on page 231

“Generate a Report with Microsoft Excel” on page 232

Useful Links “Excel Reports” on page 92
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Troubleshooting and Limitations

This section describes troubleshooting and limitations of the Report 
Manager.

Excel Reports

➤ Users who have permissions to view Microsoft Excel reports but who do not 
have permissions on specific profiles are able to view data from those 
profiles if they are included in an Excel report.

➤ Microsoft Excel reports cannot return more than 10,000 records due to an 
Microsoft Excel limitation when using Web queries. Possible workarounds 
include:

➤ split request to several consecutive queries

➤ group data using larger time range chunks

➤ use filter parameters to fetch specific data

Report Schedules and Email Reports
When attempting to schedule or email multiple reports or report objects at 
the same time, you must ensure that your selections are from the same 
group. The items are grouped as follows: 

➤ Favorite Filter and Service Report

➤ Custom Report and Trend Report
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6
Custom Reports

This chapter includes the main concepts, tasks, and reference information 
on Custom Reports.

This chapter includes:

Concepts

 ➤  Custom Reports - Overview on page 123

Reference

 ➤  Custom Reports User Interface on page 127

Troubleshooting and Limitations on page 154
Concepts

Custom Reports - Overview

Custom Reports consist of components—individual application reports that 
enable you to focus on the data you are most interested in tracking. Each 
custom report consists of components from different HP Business 
Availability Center applications.

You select components from the relevant applications, and then configure 
settings for each component, including format (chart or table), layout, and 
time settings. You also specify active filters, which enable you to design the 
report to focus on the specific information that you most want to track (for 
example, business-critical transactions or critical alerts). In addition, you 
can add a custom header and footer to the report. 

You configure Custom Reports from the Custom Report Wizard, located in 
the Report Manager. For details on configuring custom report components, 
see “Custom Reports Wizard” on page 127.
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Note: When a custom report based on a Custom time range (selected in the 
time range and granularity bar) contains Service Level Management 
components, the time ranges used for these components are adjusted to fit 
Service Level Management tracking periods. For more information, see 
“Time Ranges in Service Level Management Component Reports” on 
page 124.

Time Ranges in Service Level Management Component 
Reports
When a custom report is set to use a global time period for all components 
(so that the time range and granularity bar is displayed at the top of the 
custom report), and you select to base the report on a Custom time range 
(selected in the View box), the time range you define might not fit the 
tracking periods for any Service Level Management components included in 
the report. 

In this case, the time range for each Service Level Management component 
is automatically adjusted to correlate with Service Level Management 
tracking periods. The adjustment is made based on the From and To dates 
defined for the time range.

For over time reports (CIs Over Time, CI Over Time vs. Target), the 
automatic adjustment for both dates is to the nearest hour or nearest 
midnight, as appropriate. 

Note: The granularity supported for these report components is every 1 
hour, week, month, or year, as appropriate for the time range, with a 
maximum of 60 data points. For example, if you select a granularity of 1 day 
for a time range of a year, this would generate 365 data points, so the 
component report cannot be generated. 

For all other Service Level Management reports, the adjustment is made as 
follows: 
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➤ If the difference between the From and To date is under 2 hours, the time is 
adjusted to show the hour that starts from the From date and time (rounded 
back to the nearest hour).

➤ If the difference between the From and To date is at least 2 hours, but under 
2 days, the time is adjusted to show the day that starts from the From date 
(rounded back to the nearest midnight).

➤ If the difference between the From and To date is at least 2 days, but under 2 
weeks, the time is adjusted to the week that starts from the From date 
(rounded back to the first weekday of that week).

➤ If the difference between the From and To date is at least 2 weeks, but under 
61 days, the time is adjusted to the month that starts from the From date 
(rounded back to the first day of that month).

➤ If the difference between the From and To date is from 61 days to 121 days, 
the time is adjusted to the quarter that starts from the From date (rounded 
back to the first day of that quarter).

➤ If the difference between the From and To date is 122 days or more, the time 
is adjusted to the year that starts from the From date (rounded back to the 
first day of that year).

The adjusted time range used for the Service Level Management component 
is displayed at the top of the component report. (The settings in the time 
range bar remain as defined.) 
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In the following pictures, the custom time range for My Custom Report is set 
for 1.5 hours—from 4:40 pm to 6:10 pm. In the CI Status report component, 
the time range has been automatically adjusted to the hour from 4:00 pm - 
5:00 pm; In the CIs Over Time report component, the time range has been 
automatically adjusted to the two hour period from 4:00 pm - 6:00 pm:

Reference
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Custom Reports User Interface

This section describes:

 ➤  Custom Reports Wizard on page 127

 ➤  Custom Report Output on page 151

Custom Reports Wizard 

Report Properties Page

Description Enables you to create customized reports that present the 
data most relevant to you.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New 
Custom Report.

Wizard Map The Custom Report Wizard contains:

Report Properties Page > Report Components Page > 
Header/Footer Page > Reports Preview Page

Useful Links “Custom Reports - Overview” on page 123

Description Enables you to configure general properties for your 
custom report.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New 
Custom Report.

Important 
Information

You must enter information in the Reports Properties 
page to proceed to the next page in the Custom Report 
Wizard. 

General information about the wizard is available in 
“Custom Reports Wizard” on page 127.

Wizard Map The Custom Report Wizard contains:

Report Properties Page > Report Components Page > 
Header/Footer Page > Reports Preview Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Automatic 
Generation

Choose an automatic generation setting for your report. 
Select from the following options:

➤ Do not generate the report automatically. Select to 
ensure that the report is generated only on demand.

➤ Refresh the report every x minutes. Select to generate 
and refresh the report every x minutes. Select the 
number of minutes from the drop down box.

Insert a page break 
after each 
component when 
printing the report

Select to insert a page break after each report component 
when printing the report.

Page Title Enter a title for the custom report.

Report Name Enter a descriptive name for the custom report. 

Note. Leaving this field blank causes the value to 
automatically default to the value of the Page Title field. 

Time Period Choose Use global settings for all reports to enable one 
time period for all components, or Use separate time 
period for each report to configure a separate time 
period for each component.

Note: If you chose Use global settings for all reports, you 
configure the report coverage time frame by selecting the 
report and clicking the Create new schedule for selected 
reports button  on the Report Manager Main Page. 
For details, see "Create New Schedule Dialog Box" on 
page 124.



Chapter 6 • Custom Reports

129

Report Components Page

The following elements are included:

Description Enables you to add components to the custom report.

To access: Enter parameters on the Report Properties page 
in the Custom Reports Wizard.

Important 
Information

You select the components that present the data most 
important to you. 

After creating a custom report, if you then configure user- 
or global-level report filters to filter specific transactions, 
locations, or groups from reports, the filtered values still 
appear in the reports. To remove any newly filtered 
values from existing custom reports, you must remove 
and re-add the components containing the elements for 
which filters have been set, and save the report.

General information about the wizard is available in 
“Custom Reports Wizard” on page 127.

Wizard Map The Custom Report Wizard contains:

Report Properties Page > Report Components Page > 
Header/Footer Page > Reports Preview Page

GUI Element (A–Z) Description

Click to open the Add Component dialog box and add a 
component to the customized report. For details, see 
“Add Component Dialog Box” on page 130.

Click to configure filters for the selected component.

Click to reset the width of columns in the report 
components table. 

Click to select columns to be visible on the report 
components table. For details, see “Working with Tables” 
in Reference Information.

Entity The profile, if applicable, to which the report component 
belongs. 
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Add Component Dialog Box

Report The type of report component selected. 

Time Frame Displays a method for time range display for the 
component. 

➤ Global. One time range is applied to all report 
components. This is displayed if you chose Use one 
time period for all reports in the Time Period field on 
the Reports Properties page.

➤ <Time Interval>. The interval at which the report is to 
be generated. This is displayed if you chose Use 
separate time period for each report in the Time 
Period field on the Reports Properties page. 

Title The title of the report, as configured on the Component 
Properties page.

Width Displays the size of the report component, as configured 
on the Component Properties page:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Description Enables you to choose a component type and specific 
report to be included in your custom report. 

To access: Click the Add New Component button  on 
the Report Properties page in the Custom Report Wizard. 

GUI Element (A–Z) Description
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The following elements are included:

Important 
Information

The Add Component dialog box contains the following 
panes:

➤ Select Component Category. Select the type of 
component you want to add to the custom report. 

➤ Select Component. Configure the parameters for the 
selected component type. For details, see “Select 
Component Pane” on page 132.

Useful Links “Custom Reports Wizard” on page 127

“Report Components Page” on page 129

GUI Element (A–Z) Description

Select Component 
Category

Select the type of report component you want added to 
your custom report. 

You must click the expand button next to the application 
contexts to view the available categories to choose from.

For details on the available reports components, see 
“HP Business Availability Center Reports” on page 13.

Select Component Select the specific component you want added to your 
custom report. For details, see “Select Component Pane” 
on page 132. 
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Select Component Pane

Description Enables you to configure components to be included in 
your custom report. 

To access: Click the New Component Button  on the 
Report Components page of the Custom Report Wizard 
and choose a component category from the Select 
Component Category pane. Configure your component 
in the Select Component pane. 

Important 
Information

Not all elements in the table below are available for all 
report components. 

When selecting the Service Report Builder in the User 
Reports context, you must first create a Service Report in 
the Report Manager to enable you to add Service Reports 
as a component to your Custom Report. For details on 
adding a Service Report in the Report Manager, see 
“Configure a Service Report in Report Manager – 
Workflow” in Using My BAC.
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End User Management Components

The following elements are included (listed alphabetically):

GUI Element (A–Z) Description

Category Select a report category. 

Note. This field is available only for Business Process 
reports in the End User Management context. 

The available report categories are: 

➤ Performance Update Reports, located in “Additional 
Custom Reports” on page 157.

➤ User Experience Reports, located in Using End User 
Management:

The individual reports are then selected in the Type field.

Interval If you selected Use separate time period for each report 
when defining the report properties, select the time 
frame for which HP Business Availability Center should 
generate the report. You then configure how long ago the 
data for the report should be generated in the Start field. 
If you selected Use global setting for all reports when 
defining the report properties, this field reads Use global 
settings. 

Position Select the position for the component within the custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note. For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Profile Select a profile for the custom report component. 
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Report Select a report from the Report list. The available reports 
are displayed based on the Component Category chosen, 
as follows: 

➤ Business Process Monitor Enhanced

➤ Response Time by Percentile Report

➤ Triage Raw Data Report

➤ Triage Report

➤ Real User Monitor 

➤ End User Over Time Report

➤ End User Summary Report

➤ End Users by Page Report

➤ End Users by Transaction Report

➤ Event Analysis Report

➤ Event Count Over Time Report

➤ Event Summary Report

➤ Page Over Time Report

➤ Page Summary Report

➤ Pages by Server Summary Report

➤ Server Over Time Report

➤ Server Summary Report

➤ Servers by Page Summary Report

➤ TCP Application Summary Report

➤ Transaction Over Time Report

➤ Transaction Summary Report

➤ Real User Monitor (Old)

➤ Broken Links

➤ Most Active End Users

➤ Most Popular Pages

➤ Pages with Most Errors

➤ Pages with Slowest Server Time

➤ Slowest End Users

GUI Element (A–Z) Description
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Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Start Select how long ago the data for the report should be 
generated. The granularity for this field is measured 
according to what you chose in the Interval field.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use global setting for all 
reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

GUI Element (A–Z) Description
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Type Select the report type that you want to add to the 
Custom Report, based on the component category you 
chose:

➤ Performance Update Reports

➤ Performance Update Summary 

➤ Performance of Locations 

➤ Performance of Transactions 

➤ Transaction Availability 

For details, see “Performance Update Report” on 
page 158. 

➤ User Experience Reports, located in Using End User 
Management:

➤ Availability Over Time Report

➤ Breakdown Over Time Report

➤ Breakdown Summary Report

➤ Min./Max. Response Time Report

➤ Overall Performance by Profiles. For details, see 
Multi-Profile Summary Report.

➤ Overall Performance of 3 Worst Locations (multi-
profile). For details, see Performance of Locations. 

➤ Overall Performance of 3 Worst Profiles (multi-
profile). For details, see Multi-Profile Summary 
Report. 

➤ Performance Matrix Report

➤ Profile Summary Report in Additional Reports

➤ Response Time – 90th Percentile Report in 
Additional Reports

➤ Response Time by Percentile Report

➤ Response Time Over Time Report

For details, see “Business Process Reports Overview” on 
page 148. 

GUI Element (A–Z) Description
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System Availability Management Components

The following elements are included (listed alphabetically):

View As Select Graph or Table, depending on the format in which 
you want HP Business Availability Center to display the 
report. These options are not available for all reports. 

In a report with multi-tab layout, all tabs are displayed 
one after another.

Width Select the width of the frame size for the component. 

GUI Element (A–Z) Description

Display Select whether you want HP Business Availability Center 
to display the best- or worst-performing monitors, and 
choose the number of monitors to be displayed in the 
report in the Monitors list.

Interval If you selected Use separate time period for each report 
when defining the report properties, select the time 
frame for which HP Business Availability Center should 
generate the report. You then select the configure how 
long ago the data for the report should be generated in 
the Start field. generation If you selected Enable time 
period per component when defining the report 
properties, select the time period for which HP Business 
Availability Center initially generates the report in the 
Interval list. 

GUI Element (A–Z) Description
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Monitor Title Specify the monitors (by their title, as defined in 
SiteScope) on which you want the custom report data to 
be based.

Leave empty to instruct HP Business Availability Center 
to base the report on all values. 

You can use the asterisk symbol (*) as a wildcard to 
instruct HP Business Availability Center to base the 
report on a subset of all values. For example, to name all 
CPU monitors in SiteScope with the naming convention 
cpu_<servername>, specify cpu* to instruct HP Business 
Availability Center to include all CPU monitors in the 
custom report.

Notes. 

➤ It is not recommended to enter a wildcard as the first 
character in a string because HP Business Availability 
Center is unable to use the Index tables when 
querying the database, thus slowing report generation 
times. 

➤ This field is available only for the SiteScope Monitor 
Performance component category.

Monitor Type Select the monitor on which you want the custom report 
data to be based. To base the report on all monitors, 
choose All types.

Note. This field is available only for the SiteScope 
Monitor Performance component category.

Position Select the position for the component within the custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note. For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

GUI Element (A–Z) Description



Chapter 6 • Custom Reports

139

Profile Select a profile for the custom report component. 

Note. This field is available only for the SiteScope 
Monitor Performance component category. 

Report Select to add the Cross-Performance Report component. 

Server Name Specify the servers on which you want the custom report 
data to be based.

Leave empty to instruct HP Business Availability Center 
to base the report on all values. 

Note. This field is available only for the SiteScope 
Monitor Performance component category.

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Start Select how long ago the data for the report should be 
generated. The granularity for this field is measured 
according to what you chose in the Interval field.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

GUI Element (A–Z) Description
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User Reports

The following elements are included (listed alphabetically):

Type Select a specific SiteScope report component to add to 
your custom report. Choose from the following reports, 
located in Using System Availability Management: 

➤ Overall Performance Report

➤ SiteScope Data Over Time Report

➤ SiteScope Profile Summary Report, contained in the 
Group Performance Report. 

View As Select Graph or Table, depending on the format in which 
you want HP Business Availability Center to display the 
report. 

In a report with multi-tab layout, all tabs are displayed 
one after another.

GUI Element (A–Z) Description

Height Select the height of the frame size for the component. 

Important. Keep in mind the required frame size for 
correctly viewing the Web page content being accessed. 

Interval If you selected Use separate time period for each report 
when defining the report properties, select the time 
frame for which HP Business Availability Center should 
generate the report. You then configure how long ago the 
data for the report should be generated in the Start field. 
If you selected Enable time period per component when 
defining the report properties, this field reads Use global 
settings.

GUI Element (A–Z) Description
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Position Select the position for the component within the custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note. For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Report Select to add the Custom Query Builder report 
component. For details on the Custom Query Builder 
report, see “Custom Query Builder” on page 197.

Report Title Enter a descriptive title for the report. 

Note. This field is available only for the Service Report 
Builder component. 

Select Report Select a report to be included as a component for your 
custom report. 

Note. This field is available only for the Service Report 
Builder component. 

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

GUI Element (A–Z) Description
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URL Select to create a report that calls a specified URL. For 
example, you can integrate links to external charts 
generated by third-party EMS software into the custom 
report. You specify the URL as well as any parameters that 
you want the URL to process at runtime. 

HP Business Availability Center provides two templates 
that you can use as the arguments for parameters that 
process report times: 

➤ Start Time. Uses the argument $$startTime$$ to return 
the start time for the report.

➤ End Time. Uses the argument $$endTime$$ to return 
the end time for the report.

Example: A URL that uses parameters to return the chart 
type and start time of a report is:

http://www.myapp.com?graph=responsetime;starttime=$
$startTime$$ 

Note: If the specified Web page includes JavaScript code 
that attempts to access the top frame, the browser 
displays an "access denied" error. To avoid this issue, set 
the browser to ignore JavaScript errors.

Type the URL of the Web page you want HP Business 
Availability Center to display in the report. If the URL 
includes parameters, specify them as required. 

To use one of the predefined arguments with a parameter 
in the URL, place the insertion point in the URL where 
you want to add the argument, select the required 
argument from the URL runtime templates list, and click 
Add Template.

Note. This field is available only when the URL 
component category is selected. 

GUI Element (A–Z) Description
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Dashboard Reports

The following elements are included (listed alphabetically):

View As Select Graph or Table, depending on the format in which 
you want HP Business Availability Center to display the 
report. 

In a report with multi-tab layout, all tabs are displayed 
one after another.

Width Select the width of the frame size for the component. 

Important. Keep in mind the required frame size for 
correctly viewing the Web page content being accessed.

GUI Element (A–Z) Description

Position Select the position for the component within the custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note. For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Report Select the report you want added to your custom report. 
The available reports are located in Using Dashboard and 
are displayed according to the selected component 
category, as follows: 

➤ Business Dashboard

➤ KPIs Distribution Over Time Report

➤ KPIs Summary Report

➤ KPIs Trend Report

➤ General

➤ KPIs Over Time Report

GUI Element (A–Z) Description



Chapter 6 • Custom Reports

144

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Start Select how long ago the data for the report should be 
generated. The granularity for this field is measured 
according to what you chose in the Interval field.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

View As Select Graph or Table, depending on the format in which 
you want HP Business Availability Center to display the 
report. 

In a report with multi-tab layout, all tabs are displayed 
one after another.

GUI Element (A–Z) Description
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Alerts

The following elements are included (listed alphabetically):

GUI Element (A–Z) Description

Position Select the position for the component within the custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note. For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Report Select the report you want added to your custom report. 
Choose from the following reports, located in Alerts:

➤ Actual vs Baseline Suggested Alerts Report

➤ Actual vs. Baseline Suggested Alerts – Detailed Report

➤ Alerts Count Over Time Report

➤ Alerts Log Report

➤ Baseline Suggested Alerts Log Report

➤ Configuration Item Status Alerts Report

➤ SLA Status Alerts Report

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 
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Service Level Management

The following elements are included (listed alphabetically):

GUI Element (A–Z) Description

Position Select the position for the component within the custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note. For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Report Select the report you want added to your custom report. 
Choose from the following reports, located in Using 
Service Level Management:

➤ CI Impact Report

➤ CI Over Time vs. Target Report

➤ CI Status Report

➤ CI Summary Report

➤ CIs Over Time Report

➤ Outage Breakdown Report

➤ Outage Distribution Report

➤ Outage Summary Report

➤ SLA Status Report

➤ SLAs Summary Report

➤ Time Range Comparison Report

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.
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Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

GUI Element (A–Z) Description
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Component Filters Dialog Box

Description Enables you to configure filters for the selected 
component. 

To access: Click the Edit Filter button  on the Reports 
page in the Custom Reports wizard. 

Important 
Information

➤ The Filters button is not enabled for all the Service 
Report Builder and URL components in the User 
Reports category. 

➤ For a Time Range Comparison component, the 
Component Filters window includes a Time Ranges 
option where you set the time ranges to be compared 
in the report. 

When the custom report is set to Use global settings 
for all components, then the available time ranges 
include Global Time. The global time range is 
determined by the time range selected when the 
report is generated, or by the time range set by the 
report schedule. 

➤ If the current user does not have access permissions to 
the profile in the component (or to at least one of the 
profiles in a multi-profile component), or if the profile 
has been removed from the database, the user cannot 
edit component filters.

For details on setting report filters, see “Configure 
Report Filters Globally” in Platform Administration, 
“Report Filters Page” in Using End User Management, 
and “Active Filters Dialog Box” in Using End User 
Management.
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Header/Footer Page

Description Enables you to add a custom header or footer to your 
custom report.

To access: Enter parameters on the Report Properties and 
Report Components pages in the Custom Report Wizard.

Important 
Information

The custom header and footer can include free text, 
HTML tags used to mark up the text, hypertext links, 
JavaScript, as well as references to external resources such 
as images, Flash files, and so on. If you do not mark up 
the text, it is formatted according to the browser defaults. 

You add the custom header and footer into the Report 
Header and Report Footer panes, respectively.

HP Business Availability Center adds the HTML header to 
the report below the report filter, and the HTML footer at 
the end of the report, immediately before closing the 
body tag. 

Notes: 

➤ The header and footer you configure on the 
Header/Footer page overrides the default header and 
footer configured from the Set default header/footer 
for all Custom & Trend reports button  in the 
Report Manager. 

➤ Use caution when marking up the header and footer 
fields, as some HTML code may affect the behavior of 
HP Business Availability Center. For example, a linked 
URL may contain JavaScript that causes the URL to 
"break out" of frames. Make sure you use valid HTML.

➤ It is recommended that you perform an external check 
of the HTML code used in the header and footer, as 
HP Business Availability Center does not perform any 
validity checks on the header and footer content. 

General information about the wizard is available in 
“Custom Reports Wizard” on page 127.

Wizard Map The Custom Report Wizard contains:

Report Properties Page > Report Components Page > 
Header/Footer Page > Reports Preview Page
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Reports Preview Page

Description Displays the custom report according to the properties 
configured in the Custom Report Wizard. 

To access: Enter parameters on the Report Properties, 
Report Components, and Header/Footer pages in the 
Custom Report Wizard.

Important 
Information

General information about the wizard is available in 
“Custom Reports Wizard” on page 127.

Note to HP Software-as-a-Service Customers:

If you selected Do not generate the report automatically 
in the Automatic Generation field on the Report 
Properties page, you must click the Generate button to 
view the report data.

Wizard Map The Custom Report Wizard contains:

Report Properties Page > Report Components Page > 
Header/Footer Page > Reports Preview Page
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Custom Report Output

This is an example of a Custom Report:

Description Displays the Custom Report created in the Custom 
Report Wizard. You create Custom Reports to view the 
data that you are most interested in tracking.

To access: Select a Custom Report in the Report Manager 
main page and click the View button . 

Important 
Information

The information displayed in the Custom Report is 
dependent on the report components you added when 
configuring the report in the Custom Report Wizard.

Useful Links “Custom Reports - Overview” on page 123

“Custom Reports Wizard” on page 127
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.



Chapter 6 • Custom Reports

153

<Header/Footer> The header and footer of the report that was configured 
in one of the following locations: 

➤ The Header/Footer page of the Custom Report 
Manager. For details, see “Header/Footer Page” on 
page 149.

➤ The Default Header/Footer dialog box which is 
displayed after clicking the Set default header/footer 
for all Custom & Trend Reports button  on the 
Report Manager main page. For details, see “Default 
Header/Footer Dialog Box” on page 106.

➤ The static report header and static report footer 
configured in the HP Business Availability Center 
Infrastructure Settings. 

To configure the static report header and footer, select 
Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose the Customer Settings 
tab and the Foundations context, select Reporting, 
and locate the Display static report header and 
Display static report footer entries in the Reporting - 
Display table. Modify the Customer’s Value to the 
desired header and footer, as appropriate. 

Note: 

➤ Settings configured in the Header/Footer page of the 
Custom Report Manager override settings configured 
in the Default Header/Footer dialog box. 

➤ Settings configured in the Default Header/Footer 
dialog box override settings configured in the 
HP Business Availability Center Infrastructure Settings. 

<Report 
Components>

The title of the report component, as configured in the 
Custom Report Wizard. The specific report components 
are described in the documentation for the specific report 
that you are viewing. For a list of all HP Business 
Availability Center reports, see “HP Business Availability 
Center Reports” on page 13.

GUI Element (A-Z) Description
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Troubleshooting and Limitations

This section describes Troubleshooting and Limitations of Custom Reports, 
divided into the following sections:

➤ General. General limitations of Custom Reports.

➤ Report Components. Limitations relating to individual report components. 

General
This section describes general limitations of Custom Reports.

➤ Within any one specific component, HP Business Availability Center can 
display only those profiles that have the same settings for outlier values. In 
the Custom Report Manager, you should select a set of profiles that have the 
same setting for outlier values. For details on modifying outlier value 
settings for a profile, see “Transaction Threshold Settings” in Using End User 
Management.

➤ After creating custom reports, if you then configure user or global-level 
report filters to filter specific transactions, locations, or groups from reports, 
the filtered values still appear in the reports. To remove any newly filtered 
values from existing custom reports, you must remove and re-add the 
components containing the elements for which filters have been set, and 
save the report.

Report Components
This section describes limitations relating to individual reports components.

➤ When configuring the Service Level Management report component, when 
the custom report is set to Use global settings for all components, and a 
global time range is selected (at report generation) that does not match the 
time ranges of the SLA filtered in the Service Level Management 
component, the following message is displayed upon report generation: “No 
associated tracking periods exist.”
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➤ If you have upgraded from a previous version of HP Business Availability 
Center and have a Custom Report containing the Response Time by 
Percentile Report component whose time period ends in the past (for 
example, two days ago, three days ago, and so forth), the time range for the 
report defaults to the shortest predefined time range that includes the 
previous setting. For example, for a report that was configured to end two 
days ago, the Past Week time range is used. For a report that was configured 
to end eight days ago, the Past Month time range is used. This is true only if 
you have selected the Use separate time period for each report option in 
the Report Properties page of the Custom Report Wizard.

➤ To see data in the report after adding Business Dashboard components, you 
must select CIs and KPIs in the filter.
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7
Additional Custom Reports

This chapter describes reports that cannot be accessed directly from any 
application but that can be added to custom reports to provide additional 
information. 

This chapter includes:

Concepts

 ➤  Additional Custom Reports - Overview on page 157

 ➤  Performance Update Report on page 158

 ➤  Profile Summary Report on page 158

 ➤  Response Time – 90th Percentile Report on page 159

Reference

 ➤  Performance Update Report - User Interface on page 162

 ➤  Profile Summary Report - User Interface on page 165

 ➤  Response Time – 90th Percentile Report - User Interface on page 167
Concepts

Additional Custom Reports - Overview

The additional custom reports cannot be accessed directly from any 
application, but they can be added to custom reports to provide additional 
information. Additional custom reports display information about 
transaction response times and availability for Business Process Monitor 
profiles. For details on Custom Reports, see “Custom Reports” on page 123.

For details on working with reports, see “Working in Reports” on page 35.
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The following reports are available:

➤ Performance Update Report. For details, see “Performance Update Report” 
on page 158.

➤ Profile Summary Report. For details, see “Profile Summary Report” on 
page 158.

➤ Response Time - 90th Percentile Report. For details, see “Response Time – 
90th Percentile Report” on page 159.

Performance Update Report

The Performance Update report is a scheduled report that is configured to be 
sent to specified recipients, via email, on a periodic basis. The report 
includes key metrics on the performance of the transactions and locations 
defined in a specific profile.

You add components of the Performance Update report to custom reports. 
For details on the Performance Update Report User Interface, see 
“Performance Update Report - User Interface” on page 162.

Profile Summary Report

The Profile Summary displays an overview of the transaction response time 
and availability for each Business Process Monitor profile that you add to 
the report. For details on configuring Custom Reports and their 
components, see “Custom Reports Wizard” on page 127.

For details on the Profile Summary Report User Interface, see “Profile 
Summary Report - User Interface” on page 165.
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Response Time – 90th Percentile Report

The Response Time – 90th Percentile report does not appear in any 
application and can be added only to custom reports to provide additional 
information. For details, see “Custom Reports Wizard” on page 127.

The Response Time – 90th Percentile displays, for each indicated point in 
time, the specific response time value that 90 percent of all measured 
response time values are equal to or below. You can view the data in either 
chart or table format.

When calculating each point along the chart (or value in the table), 
HP Business Availability Center considers all transaction instances between 
the given point in time and the following point. For example, when 
displaying the report in the "Day" resolution, HP Business Availability 
Center divides the x-axis (or table) per hour. The value at each point along 
the chart (or in each cell in the table) represents the 90th percentile for the 
following hour.

In the above chart, 90% of the transactions that ran between 9:00 AM and 
9:59 AM had response times equal to or below 23.757.
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The Response Time – 90th Percentile data helps you identify response time 
problems and pinpoint their source. Because the data excludes response 
times above the 90th percentile (the highest 10 percent of response times), 
non-representative or non-typical transaction instances (for example, 
transactions that run during a server reboot) are eliminated. Thus, the data 
provides a more accurate picture of transaction performance over the 
defined time period.

By breaking down the data by transaction, location, or group across 
different time frames, you can identify exactly where and when transaction 
response times are too slow. For example, you might determine that 
response times in the 90th percentile for transactions from a specific 
location are consistently high over the course of several hours. This might 
indicate a problem somewhere along the network between that location and 
the monitored Web site.

You can further analyze the Response Time – 90th Percentile data as 
described below:

➤ place your cursor over any small square along the chart to view a tooltip 
containing details about the specific response time value that 90 percent of 
all response time values were equal to or below.

➤ modify the report time frame and click Generate to generate the modified 
report.

➤ drill down in the chart view. Click any time point in the chart to increase 
the time resolution for the selected transaction, location, or group. Click 
any drill down link to the right of the report, to focus on that transaction, 
location, or group.

➤ drill down in the table view. Click any link in a column or row header to 
focus on a specific time frame, transaction, location or group.

➤ select the table view in the Custom Report Manager to display the report in 
table format.
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The table displays, for each point in time, the specific response time value 
that 90 percent of all response time values were equal to or below. You can 
view the table broken down by transaction, location, or group.

➤ apply component filters in the Custom Report Manager. Click the 
Component Filters button, and select or clear check boxes to view the report 
filtered by specific transactions, locations, or groups.

Reference
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Performance Update Report - User Interface

This is an example of the Performance Update Report:
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays key metrics on the performance of the 
transactions and locations defined in a specific profile.

To access: You view the Performance Update report either 
in your email client or in a Web browser. You can view 
the Performance Update Report from a custom report to 
which the Performance Update Report component has 
been added. 

Important 
Information

You define transaction thresholds—to specify the OK, 
Warning, and Poor range for each transaction—when 
you create a profile. You can also modify the transaction 
threshold ranges, as well as the default outlier value of 45 
seconds, from End User Management Administration. 
For details, see “Edit Transaction Monitor Page” on 
page 124 in Using End User Management.

Useful Links “Performance Update Report” on page 158

“Custom Reports” on page 123

GUI Element (A–Z) Description

<Common report 
settings>

For details, see “Common Report Elements” on page 51.

Report Title and 
Frequency

Displays the title of the report, and in parentheses the 
report frequency.

Time Zone and Time 
Frame for Report

Displays the configured time zone relative to GMT, as 
well as the time frame of the report. For a reference list of 
GMT time zones for locations throughout the world, see 
“GMT Time Zones” in Reference Information.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Outlier transaction 
reporting status>

Describes whether HP Business Availability Center 
ignores outlier transactions in reports, or treats them as 
failed transactions (this setting is defined during profile 
definition in End User Management Administration).

Alerts Sent Displays the total number of alerts sent, including the 
number of critical severity alerts, for the measured 
period.

Availability Displays the percentage of transactions that succeeded 
(did not fail) during the measured period.

Failed Transactions Displays the total number of failed transactions for the 
measured period.

Outlier Transactions Displays the total number of outlier transactions for the 
measured period.

Performance of 
Locations

Displays, for the measured period and for each location, 
the percentage of transactions that fell into each defined 
transaction threshold range, (OK, Warning, and Poor), 
the percentage of failed transaction instances, the total 
number of transactions, and the percentage of outlier 
transactions.

Performance of 
Transactions

Displays, for the measured period and for each 
transaction, average transaction response time, the 
percentage of transaction instances that fell into each 
defined transaction threshold range, (OK, Warning, and 
Poor), the percentage of failed transaction instances, the 
total number of transaction instances, and the 
percentage of outlier transaction instances.

Performance Update 
Summary

Displays the transaction availability and total alerts sent 
for the measured period. 

Profile name Displays the Business Process profile upon which the 
report is based.
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Profile Summary Report - User Interface

This is an example of the Profile Summary Report:

Total Transactions Displays the total number of transactions run during the 
measured period.

Transaction 
Availability

Displays the availability rate for each transaction in the 
profile, for the measured period. If a description of the 
transaction is set, the description is displayed (this 
setting is defined during transaction monitor 
configuration in End User Management Administration).

Description Displays an overview of the transaction response time 
and availability for each Business Process Monitor profile 
that you add to the custom report. 

To access: You can view the Profile Summary Report in 
custom report to which the Profile Summary Report 
component has been added. 

Important 
Information

If you apply active filters, only the selected transactions, 
locations, and groups are included. For details on 
applying active filters, see “Active Filters Dialog Box” in 
Using End User Management.

Useful Links “Profile Summary Report” on page 158

“Custom Reports” on page 123

GUI Element (A–Z) Description
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Common report 
settings>

For details, see “Common Report Elements” on page 51.

Performance Displays the performance level for the selected profile, 
indicated by a colored icon. For details on the color 
codes, see 

Profile Name Displays the Business Process profile upon which the 
report is based. 

You can click the profile name to generate a Transaction 
Analysis Report for the profile. For details, see 
“Transaction Analysis Report” in Using End User 
Management.

Transaction 
Availability

Displays the availability of the transactions running on 
the selected profile, indicated by a colored icon. For 
details on the color codes, see “Report Content” on 
page 166.

GUI Element (A–Z) Description

<Gray Icon> ➤ Performance. Indicates that no transaction data is 
defined. 

➤ Transaction Availability. N/A

<Green Icon> ➤ Performance. Indicates that each transaction's average 
response time fell within the OK threshold level. 

➤ Transaction Availability. Indicates that no transactions 
failed.
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Response Time – 90th Percentile Report - User Interface

This is an example of the Response Time - 90th Percentile Report:

<Profile Name> The name of the Business Process profile upon which the 
report is based. 

<Red Icon> ➤ Performance. Indicates that at least one transaction's 
average response time fell within the Critical threshold 
level. 

➤ Transaction Availability. Indicates that at least one 
transaction failed. 

<Yellow Icon> ➤ Performance. Indicates that at least one transaction's 
average response time fell within the Minor threshold 
level, but no transaction's average response time fell 
within the Critical threshold level. 

➤ Transaction Availability. N/A

GUI Element (A–Z) Description
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays, for each indicated point in time, the specific 
response time value that 90 percent of all measured 
response time values are equal to or below. 

To access: Select Applications > User Reports > New > 
New Custom Report, navigate to the Report Components 
Page and click the Add New Component button . 
Select Business Process in the End User Management 
component category and select User Experience Reports 
in the Category field. In the Type field, select Response 
Time - 90th Percentile. 

Important 
Information

You can apply component filters in the Custom Report 
Wizard by clicking the Component Filters button , 
and select or clear check boxes to view the report filtered 
by specific transactions, locations, or groups.

Useful Links “Response Time – 90th Percentile Report” on page 159

“Custom Reports” on page 123

GUI Element (A–Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Profile The Business Process profile upon which the report is 
based.
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Report Content - Graph View

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Report Content - Table View

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<drill down link> Click any drill down link to the right of the report to 
focus on that transaction, location, or group.

<small square on 
chart>

➤ Place your cursor over any small square along the 
graph to view a tooltip containing details about the 
specific response time value that 90 percent of all 
response time values were equal to or below.

➤ Click any time point in the graph to increase the time 
resolution for the selected transaction, location, or 
group.

Response Time (sec.) The time, in seconds, that the report data is generated 
for.

Time Range The time frame that the report data is generated over. 
The intervals displayed depend on the granularity chosen 
in the Every field. 

GUI Element (A–Z) Description

<Date and Time> The date and time that the data is generated for in the 
given transaction. The time interval depends on the 
granularity selected in the Every field. 

<Transaction Name> The name of the transaction in the profile being 
monitored.

<Values in Table> The specific response time value that 90 percent of all 
response time values were equal to or below for the given 
point in time. 
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8
Trend Reports

This chapter includes the main concepts, tasks, and reference information 
for Trend Reports.

This chapter includes:

Concepts

 ➤  Trend Reports - Overview on page 171

Reference

 ➤  Trend Reports User Interface on page 172

Troubleshooting and Limitations on page 195
Concepts

Trend Reports - Overview

Trend reports enable you to compare multiple measurements from several 
profiles collected by Business Process Monitor, Real User Monitor, and 
SiteScope, including transaction response time and availability data and 
SiteScope data. In addition, you can add custom monitor data—including 
Real User Monitor data—to trend reports.

By combining measurements for several monitors on the same chart, you 
can analyze the relationship between transaction response time and 
availability, network and server health, and infrastructure machine 
performance over a selected time range.

Trend Reports also enable you to compare the same set of measurements 
over two time periods (for example, you can compare measurements for the 
past hour and the hour before that).
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You can also display data using different data aggregation methods and 
according to different groupings, and adjust the scale used when displaying 
a measurement. In addition, you can add a custom header and footer to the 
trend report, and you can view raw data when choosing a time range of two 
days or less. 

When HP Business Availability Center generates the trend report, it displays 
data in time segments that differ depending on the time granularity you 
select in the time range bar. For details on using the time range bar, see 
“Time Range and Granularity Bar” on page 66.

You can compare the measurements in a trend report for the selected time 
range to the same set of measurements over a similar time period, but for a 
different start date. For example, to compare performance over two 
consecutive days, you could generate a trend report for one day starting Dec. 
12 at midnight, and then generate the comparison data for one day starting 
Dec. 11 at midnight. 

Trend Reports are configured in the Trend Report Wizard, accessible from 
the Report Manager in the User Reports application. For details on 
configuring a Trend Report, see “Trend Reports Wizard” on page 173.

You view existing Trend Reports by selecting the Trend Report in the Report 
Manager in the User Reports application and clicking the View button. For 
details on the Trend Report User Interface, see “Trend Report Output” on 
page 186.

Reference

Trend Reports User Interface

This section describes:

 ➤  Trend Reports Wizard on page 173

 ➤  Trend Report Output on page 186



Chapter 8 • Trend Reports

173

Trend Reports Wizard 

Trend Properties Page

Description Enables you to configure a Trend Report in the Report 
Manager to compare multiple measurements from 
various monitors. 

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New Trend 
Report.

Wizard Map The Trend Report Wizard contains:

Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page

Useful Links “Trend Reports - Overview” on page 171

Description Enables you to configure properties for your trend report.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New Trend 
Report.

Important 
Information

General information about the wizard is available in 
“Trend Reports Wizard” on page 173.

Wizard Map The Trend Report Wizard contains:

Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Comparison start 
time

Click the checkbox to enable comparison of the 
measurements in the trend report over multiple time 
periods. Click the date and time link to select a date and 
time for the comparison data to be measured. 

Example: To compare performance over two consecutive 
days, you could generate a trend report for one day 
starting Dec. 12 at midnight, and then generate the 
comparison data for one day starting Dec. 11 at 
midnight. 

Page title Enter a descriptive name for the report. This name 
appears at the top of the report display page.

Report name Specify a report name to appear in the Report Manager.

Default value: The page title value. 

Y-axis label Enter the required label of the Y-axis. This text is used for 
the Y-axis in report charts.
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Select Measurements Page

Description Enables you to select the measurements to display in the 
merged report chart. 

To access: Enter information in the Trend Properties page 
of the Trend Report Wizard.

Important 
Information

➤ You can add up to 20 measurements to a trend report. 
Measurements are grouped into tables by monitor 
type.

➤ Administrators can modify the maximum number of 
measurements displayed in a report. To modify this 
setting, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings. Select the 
Applications context and choose End User 
Management/System Availability Management from 
the list. Locate the End User Management/System 
Availability Management - Data table. Make the 
change to the value in the Max Trend Report 
Measurements setting. 

➤ The fields displayed on the tables that appear on this 
page are configured on the measurement selection 
page. For an explanation of these fields, see 
“Measurement Selection Page” on page 178.

➤ You can optionally adjust the name and color of 
configured measurements, as well as the scale factor 
for each measurement in the Scale field on the table. 
For details on adjusting the scale factor, see “Trend 
Report Output” on page 186. 

➤ General information about the wizard is available in 
“Trend Reports Wizard” on page 173.

Wizard Map The Trend Report Wizard contains:

Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Adjusting the Trend Report Scale

Measurement values in the trend report are displayed along the y-axis using 
a normalized scale. By default, HP Business Availability Center automatically 
sets the scale factor for each measurement. If required, you can manually 
modify the scale factor for any measurement in the table on the Select 

GUI Element (A-Z) Description

<color box/color 
swatch>

Displays the color of the selected measurement in the 
report. Click the color swatch to customize the color. 

Aggregation The data aggregation method for the selected 
measurement.

Group The monitor group, as defined in the host properties.

Location The location of the host machine. 

Note: This field is visible only for Business Process 
Monitor measurements.

Measurement The measurement being monitored by the trend report. 

Name The name of the trend report. 

Tooltip: The full name of the trend report, as per the 
counter and transaction configured on the Measurement 
Selection page. 

Profile The monitor profile that the selected measurement is 
associated with. 

Scale The scale setting by which HP Business Availability 
Center divides by the actual measurement value. Thus, a 
value of 100 with a scale setting of 0.1 is shown as 1000 
along the y-axis. A value of 100 with a scale setting of 10 
is shown as 10 along the y-axis. For details on adjusting 
the Trend Report scale, see “Adjusting the Trend Report 
Scale” on page 176.

Transaction The monitor transaction that the selected measurement 
is associated with.
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Measurements page, for example, to better view multiple measurements 
whose data values span a wide range. For details, see “Select Measurements 
Page” on page 175.

When you manually modify the scale factor, HP Business Availability Center 
scales measurement values by dividing the actual value by the value chosen 
in the scale list. Thus, a value of 100 with a scale setting of 0.1 is shown as 
1000 along the y-axis. A value of 100 with a scale setting of 10 is shown as 
10 along the y-axis.

For example, if at a given point in time Measurement A (whose scale value is 
set to "Auto") has a value of 10 and Measurement B (whose scale value is set 
to 0.1) has a value of 90, the y-axis displays a range from 0-1000 to 
accommodate both values. If both measurements’ scale settings are set to 
"Auto," the y-axis values ranges from 0-100.
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Measurement Selection Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select measurements to add to your trend 
report, per monitor type.

To access: Click the Add Measurements button  on 
the Select Measurements page of the Trend Reports 
Wizard. 

Important 
Information

➤ Depending on the monitor type you choose, 
HP Business Availability Center displays various filters 
to determine which measurements are to appear in the 
trend report. You must select an entry from each list. 

➤ Measurement filters differ per monitor category.

➤ For each monitor category, HP Business Availability 
Center displays the counters (measurements) that are 
relevant to the selected groups or data types. You select 
the relevant counter (measurement) to add to your 
Trend report.

➤ After creating trend reports, if you then configure user- 
or global-level report filters to filter specific 
transactions, locations, or groups from reports, the 
filtered values still appear in the reports. To remove 
any newly filtered values from existing trend reports, 
you must remove and re-add the components 
containing the elements for which filters have been 
set, and save the report. 

Useful Links “Trend Reports Wizard” on page 173

GUI Element (A-Z) Description

Click to activate the search for the data in the Contains 
box.

Contains Enter the measurement you want to search for in the 
selected filter.
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Data Aggregation 
Method

Select a data aggregation method. 

HP Business Availability Center calculates the data to 
display for each time segment based on the data 
aggregation method you choose:

➤ Average. For each time segment, calculates and 
displays the average of all data collected during that 
segment.

➤ Maximum. For each time segment, displays the single 
highest data value that occurred during that segment.

➤ Minimum. For each time segment, displays the single 
lowest data value that occurred during that segment.

➤ Count. For each time segment, displays the number 
(count) of data values that occurred during that 
segment.

➤ Sum. For each time segment, displays the sum of data 
values that occurred during that segment.

Group by Select a format by which to group results. 

➤ Transaction. Results are shown per transaction.

➤ Location. Results are shown per host machine 
location.

➤ Group. Results are shown per group, as defined in the 
host properties.

Note: This field is visible only if you chose the Business 
Process Monitor monitor type. 

GUI Element (A-Z) Description
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Monitor Type Select the type of monitor whose filters you want to 
select measurements from to include in the Trend Report. 
The available monitors are:

➤ Business Process Monitor. Transaction-related data 
collected by the Business Process Monitor. For details 
on Business Process Monitor filters, see “Business 
Process Monitor Filters” on page 181.

➤ WebTrace. WebTrace or traceroute data collected by 
the Business Process Monitor.

➤ SiteScope. Infrastructure machine-related data 
collected by SiteScope. 

➤ Real User Monitor. Network and server performance 
and availability data in real time collected by the Real 
User Monitor.

Real User Monitor trend reports analyze the trend of 
performance and availability data for the servers, 
pages, transactions, and end users that you configure 
for monitoring.

Note. The data types listed under Real User Monitor 
(Pages, Transactions, End Users) are the same as the 
RUM Pages, RUM Transactions, and RUM End Users 
data types listed in the Custom monitor type list. 
Selecting them from the Real User Monitor monitor 
type list saves having to define measurement filters for 
them in the Measurement Filters page. 

➤ Custom. Custom monitor data for which a filter has 
been defined in the Measurement Filters page. For 
details, see “Working with Measurement Filters” in 
Platform Administration.

GUI Element (A-Z) Description
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Business Process Monitor Filters

The following elements are included (listed alphabetically):

WebTrace Filters

The following elements are included (listed alphabetically):

GUI Element (A-Z) Description

Counter Transaction response time, transaction breakdown, and 
transaction availability data collected by Business Process 
Monitor. 

Group Defined groups to which hosts were assigned during 
profile creation.

Location Defined host locations (machines on which HP Business 
Availability Center Business Process Monitor Agent is 
running). 

Profile Business Process Monitor profiles.

Transaction Defined transactions in scripts assigned to profiles.

GUI Element (A-Z) Description

Counter WebTrace/traceroute data collected by Business Process 
Monitor.

Location Defined host locations (machines on which HP Business 
Availability Center Business Process Monitor Agent is 
running). 

Profile Business Process Monitor profiles.
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SiteScope Filters

The following elements are included (listed alphabetically):

Real User Monitor Filters

The following elements are included (listed alphabetically):

GUI Element (A-Z) Description

Group Tree Defined SiteScope groups and subgroups for the profile.

Measurement SiteScope monitor and measurement information, 
displayed using the following syntax: 

monitor title | monitored server | counter

Profile SiteScope profiles (one per SiteScope).

Top Groups Defined top-level SiteScope groups for the profile.

GUI Element (A-Z) Description

Data Type The type of data. Data types include:

➤ Pages. The pages that have been configured for 
monitoring by Real User Monitor.

➤ Transactions. The transactions that have been 
configured for monitoring by Real User Monitor.

➤ End Users. The end users that have been configured 
for monitoring by Real User Monitor.

Groups Groups of pages/transactions/end users as defined in End 
User Management. For details on configuring groups, see 
“Real User Monitor Administration” in End User 
Management.

Items The pages/transactions/end users of the selected groups; 
this is the actual filter that is to be used.

Measurements All measurements defined for the selected data type.
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Custom Filters

The following elements are included (listed alphabetically):

GUI Element (A-Z) Description

Data Type The type of data for which the measurement filter is 
created.

Dimension The name of a specific filter field.

Dimension Values A specific instance of a field in custom data chosen when 
defining a measurement filter. You use dimension values 
to group data in a trend report.

Filter Category Defined groups, created in the Measurement Filters page 
in Platform Administration, that help organize 
measurement filters into manageable groupings. 

Filter Name The name of the measurement filter, created in the 
Measurement Filters page in Platform Administration, 
used to filter incoming custom data.

Measurement The available measurements for the selected data type.
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Header/Footer Page

Description Enables you to add a custom header or footer to your 
Trend report.

To access: Enter parameters on the Trend Properties and 
Select Measurements pages in the Trend Report Wizard.

Important 
Information

The custom header and footer can include free text, 
HTML tags used to mark up the text, hypertext links, 
JavaScript, as well as references to external resources such 
as images, Flash files, and so on. If you do not mark up 
the text, it is formatted according to the browser defaults. 

You add the custom header and footer into the Report 
Header and Report Footer panes, respectively.

HP Business Availability Center adds the HTML header to 
the report below the report filter, and the HTML footer at 
the end of the report, immediately before closing the 
body tag. 

Notes: 

➤ The header and footer you configure on the 
Header/Footer page overrides the default header and 
footer configured from the Set default header/footer 
for all Custom & Trend reports button  in the 
Report Manager. 

➤ Use caution when marking up the header and footer 
fields, as some HTML code may affect the behavior of 
HP Business Availability Center. For example, a linked 
URL may contain JavaScript that causes the URL to 
"break out" of frames. Make sure you use valid HTML.

➤ It is recommended that you perform an external check 
of the HTML code used in the header and footer, as 
HP Business Availability Center does not perform any 
validity checks on the header and footer content. 

General information about the wizard is available in 
“Trend Reports Wizard” on page 173.

Wizard Map The Trend Report Wizard contains:

Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page 
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Preview Report Page

Description Displays the trend report according to the properties 
configured in the Trend Report Wizard. 

To access: Enter parameters on the Report Properties and 
Report Components, and Header/Footer pages in the 
Trend Report Wizard.

Important 
Information

➤ You can choose to view the report either in Graph or 
Table format by clicking the appropriate tab. 

➤ General information about the wizard is available in 
“Trend Reports Wizard” on page 173.

Wizard Map The Trend Report Wizard contains:

Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page 
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Trend Report Output

This is an example of a Trend Report:
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Report Settings
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a data comparison of multiple measurements 
from several profiles collected by Business Process 
Monitor and SiteScope. Trend Reports enable you to 
analyze the effect of various aspects of your system on 
transaction response time. 

To access: Select Applications > User Reports > Report 
Manager, select a Trend Report in the table and click the 
View button  to view the Trend Report.

Important 
Information

➤ Choose the View as Graph tab to view the Trend 
Report data in graph format. 

➤ Choose the View as Table tab to view the Trend Report 
data in table format. 

➤ After creating trend reports, if you then configure user- 
or global- level report filters to filter specific 
transactions, locations, or groups from reports, the 
filtered values still appear in the reports. To remove 
any newly filtered values from existing trend reports, 
you must remove and re-add the components 
containing the elements for which filters have been 
set, and save the report.

Useful Links “Trend Reports - Overview”

GUI Element (A-Z) Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.
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Every Click to set a granularity by which to view the report. For 
details on setting the granularity of reports, see “Time 
Range and Granularity Bar” on page 66.

Raw Data Click to view every instance of data output for the 
selected transaction. 

Notes: 

➤ A point on the graph appears when there is a change 
in the data value or measurement frequency from the 
previous time point on the graph. However, if there 
has been no change in either of these areas over the 
course of one hour, a point is nevertheless displayed 
on the graph.

➤ A straight line on the graph with no points indicates 
the following:

➤ There has been no change in the value of the 
incoming data from the previous time point on the 
graph.

➤ There has been no change in the frequency that the 
incoming data is measured in since the previous 
time point on the graph.

➤ A gap in the graph indicates that no data has been 
retrieved for the specific time period.

GUI Element (A-Z) Description
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Report Content as Graph
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<data points> The time intervals that data is displayed for, based on the 
chosen granularity. For example, if you chose to view 
data every hour from March 18, 2008 at 2:00 PM to 
March 19, 2008 at 2:00 PM, the x-axis displays points of 
data for every hour from the report’s start time to its end 
time. If Raw data is chosen instead of a granularity, every 
instance of a change in data output for the select 
transaction is displayed. 

Comparison Time The time range which the selected trend report is being 
compared with. 

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

The Comparison Time Graph contains: 

➤ y-axis. The value of the y-axis, as configured in the 
Trend Properties page in the Trend Report Wizard.

➤ <time stamp>. The time range and granularity for 
which report data is displayed, based on the 
configurations set on the Time Range and Granularity 
Bar. For details on the Time Range and Granularity 
Bar, see “Time Range and Granularity Bar” on page 66.

Report Time The time range of the generated report. The Report Time 
graph contains: 

➤ y-axis. The value of the y-axis, as configured in the 
Trend Properties page in the Trend Report Wizard.

➤ <time stamp>. The time range and granularity for 
which report data is displayed, based on the 
configurations set on the Time Range and Granularity 
Bar. For details on the Time Range and Granularity 
Bar, see “Time Range and Granularity Bar” on page 66.
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Selected Measurements Table

The selected Measurements Table contains the following elements (not all 
elements appear for all monitor types):

Selected 
Measurements

The measurements chosen for the Trend Report, grouped 
by monitor type, as configured in the Trend Report 
Wizard. For details, see “Selected Measurements Table” 
on page 190. 

Time Comparison The time frames that data is to be compared for. This 
table contains the following elements: 

➤ <left most column>. Lists the table on which the time 
comparison is being measured.

➤ From. The time that the data comparison in the 
selected Trend Report is to start.

➤ To. The time that the data comparison in the selected 
Trend Report is to start.

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

GUI Element (A-Z) Description

<color box/color 
swatch>

Displays the color of the selected measurement in the 
report, as configured in the Trend Report Wizard. Click 
the color swatch to customize the color. 

Aggregation The data aggregation method for the selected 
measurement.

Group The monitor group, as defined in the host properties.

Location The location of the host machine. 

Note: This field is visible only for Business Process 
Monitor measurements.

Measurement The measurement being monitored by the trend report. 

GUI Element (A-Z) Description
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Name The name of the trend report. 

Tooltip: The full name of the trend report, as per the 
counter and transaction configured on the Measurement 
Selection page. 

Profile The monitor profile that the selected measurement is 
associated with. 

Scale The scale setting configured in the Trend Report Wizard 
which HP Business Availability Center divides by the 
actual measurement value. Thus, a value of 100 with a 
scale setting of 0.1 is shown as 1000 along the y-axis. A 
value of 100 with a scale setting of 10 is shown as 10 
along the y-axis.

Transaction The monitor transaction that the selected measurement 
is associated with.

Used Aggr. Data Displays which aggregation table data was taken from. 
Options are: 

➤ Daily 

➤ Hourly

Note: This option is not relevant for raw data.

GUI Element (A-Z) Description
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Report Content as Table
When the View as Table option is chosen, the elements displayed depend on 
whether you have chosen to view aggregated data or raw data:

Aggregated Data Elements

The following elements are displayed when the Every option is selected on 
the Time Range and Granularity Bar:

GUI Element (A-Z) Description

<color box/color 
swatch>

Displays the color of the selected measurement in the 
report, as configured in the Trend Report Wizard. Click 
the color swatch to customize the color. 

<measurement name 
headers>

The measurement name headers correspond to the 
selections made on the Measurement Selection page, 
accessible from the Select Measurements page in the 
Trend Report Wizard. For details, see “Measurement 
Selection Page” on page 178.

Note: <measurement name headers> are displayed only 
when the Every option is selected on the Time Range and 
Granularity bar. For details on the Time Range and 
Granularity Bar, see “Time Range and Granularity Bar” 
on page 66.

<time intervals> Data output for the displayed time. 

Note: <time intervals> are displayed only when the Every 
option is selected on the Time Range and Granularity 
bar. For details on the Time Range and Granularity Bar, 
see “Time Range and Granularity Bar” on page 66.

Report Time The time range of the generated report. The Report Time 
graph contains: 

➤ y-axis. The value of the y-axis, as configured in the 
Trend Properties page in the Trend Report Wizard.

➤ <time stamp>. The time range and granularity for 
which report data is displayed, based on the 
configurations set on the Time Range and Granularity 
Bar. For details on the Time Range and Granularity 
Bar, see “Time Range and Granularity Bar” on page 66.
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Selected 
Measurements

The measurements chosen for the Trend Report, grouped 
by monitor type, as configured in the Trend Report 
Wizard. For details, see “Selected Measurements Table” 
on page 190. 

Time Comparison The time frames that data is to be compared for. This 
table contains the following elements: 

➤ Name. The name of the transaction being measured.

➤ <Date and Time> The data and time that the data is 
being measured for. The data and time entries that 
appear are dependent on the configurations set on the 
Time Range and Granularity bar. For details on the 
Time Range and Granularity Bar, see “Time Range and 
Granularity Bar” on page 66

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

GUI Element (A-Z) Description
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Raw Data Elements

The following elements are displayed when the Raw Data option is selected 
on the Time Range and Granularity Bar:

The last two tables are the same as in aggregated. The difference is in Time, 
Measurement, and Value.

GUI Element (A-Z) Description

Comparison Time The time range which the selected trend report is being 
compared with. 

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

The Comparison Time Graph contains: 

➤ y-axis. The value of the y-axis, as configured in the 
Trend Properties page in the Trend Report Wizard.

➤ <time stamp>. The time range and granularity for 
which report data is displayed, based on the 
configurations set on the Time Range and Granularity 
Bar. For details on the Time Range and Granularity 
Bar, see “Time Range and Granularity Bar” on page 66.

Report Time The time range of the generated report, based on the 
configurations set on Time Range and Granularity Bar. 
This table displays the following elements: 

➤ Time. The time that the selected data is generated for 
in the Trend Report.

➤ Measurement. The measurement being monitored by 
the Trend Report. 

➤ Value. The value of the data in the specific 
measurement being monitored by the Trend Report.
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Troubleshooting and Limitations

➤ After creating trend reports, if you then configure user- or global- level 
report filters to filter specific transactions, locations, or groups from reports, 
the filtered values still appear in the reports. To remove any newly filtered 
values from existing trend reports, you must remove and re-add the 
components containing the elements for which filters have been set, and 
save the report.

➤ Permissions are granted by system administrators via the Users and 
Permissions interface, and can be enabled or revoked at any time. Thus, 
permissions to modify a trend report that you create could be removed by 
the administrator at a later time.

➤ Transactions whose response times exceed their outlier value (set in 
Transaction Threshold settings in System Availability Management) are 
always displayed in trend reports as failed transactions, even if the Ignore 
outlier data in reports setting is selected for the profile to which the 
transactions belong.

Selected 
Measurements

Displays tables of the measurements selected on the 
Measurement Selection Page, accessed from the Select 
Measurement page of the Trend Report Wizard. For 
details, see “Measurement Selection Page” on page 178.

Time Comparison The time frames that data is to be compared for. This 
table contains the following elements: 

➤ <left most column>. Lists the table on which the time 
comparison is being measured.

➤ From. The time that the data comparison in the 
selected Trend Report is to start.

➤ To. The time that the data comparison in the selected 
Trend Report is to start.

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

GUI Element (A-Z) Description
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9
Custom Query Builder

This chapter includes the main concepts, tasks, and reference information 
for the Custom Query Builder.

This chapter includes:

Concepts

 ➤  Custom Query Builder - Overview on page 197

Tasks

 ➤  Build a Custom Query – Workflow on page 198

Reference

 ➤  Custom Query Builder User Interface on page 201
Concepts

Custom Query Builder - Overview

The Custom Query Builder is a Web interface that assists in creating queries 
to the profile database. The queries are used to generate reports. The Custom 
Query Builder can also generate an HTML query string that can be used 
together with third-party tools or proprietary tools to extract data from the 
profile database. 

Getting Metadata on the Samples
When building queries, you must know the data representation of the 
sample. For information on commonly queried samples and descriptions of 
their fields, click “Data Samples” in Reference Information.
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Configuration
You can set the maximum number of data rows returned at Admin > 
Platform > Setup and Maintenance > Infrastructure Settings > Foundations 
> Generic Data Engine Open API. Edit the Maximum Rows setting as 
required.

Note that the Enable Open API setting does not affect the Custom Query 
Builder.

Supported Syntax and Limitations
For a list of supported SQL syntax and query limitations, see “Supported 
SQL Syntax” and “Query Limitations” in Solutions and Integrations.

Tasks

Build a Custom Query – Workflow

This task describes the working order for building a Custom Query.

Note: If you are accessing the Custom Query Builder from the Custom 
Report Wizard, you must click the Edit Filter button after selecting the 
Custom Query component to configure the Custom Query in your Custom 
Report.

This task includes the following steps:

➤ “Select the Time Range” on page 199

➤ “Select Data Type” on page 199

➤ “Select Data Field” on page 199

➤ “Apply Filters” on page 200

➤ “Configure Presentation Settings” on page 200

➤ “Select Refresh Rate for Report (My BAC Portlet Only)” on page 200

➤ “Generate or Save the Query” on page 200
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 1 Select the Time Range

 a Select the time range of the data to be extracted from the database. (Not 
relevant if accessing Custom Query Builder from the Custom Report 
Wizard.)

Using the time range selector bar, specify the time range for which you 
want to extract data. For details, see “Time Range and Granularity Bar” 
on page 66.

 b If you want returned data grouped according to a specific granularity 
setting (for example, if you want data for the past day grouped per hour), 
select Return data per specified granularity and specify a granularity 
setting.

Example

The time bar is set to extract data from March 3, 2008 at 5:02 PM until 
March 4, 2008 at 5:02 PM, according to the GMT + 2:00 time zone.

 2 Select Data Type
Select the type of data you want to extract from the database.

From the Sample type list, select a data sample type. For a description of the 
available sample types, see “Data Samples” in Reference Information.

 3 Select Data Field
Select the data fields of the chosen sample type that you want to extract 
from the database and the functions to perform on the data. Optionally, you 
can change the Field Alias of the Field by modifying the Alias Name field. 
Click Add to add the field. For detailed descriptions of the available data 
fields per sample type, see “Data Samples” in Reference Information.
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 4 Apply Filters
Click the Filter Builder button to apply filters to the data to be extracted by 
the query. For details on applying filters, see “Filter Dialog Box” on 
page 213.

 5 Apply Field Properties
Click the Field Properties button to define custom properties for the field. 
For details on defining custom properties, see “<Field alias> Field Properties 
Dialog Box” on page 206.

 6 Configure Presentation Settings
Configure presentation settings to instruct HP Business Availability Center 
how to present the data in the report. For details, see “Presentation Settings 
Wizard” on page 215.

 7 Select Refresh Rate for Report (My BAC Portlet Only)
In the Advanced Settings table, select a refresh rate for the report (either 
every 1 hour or every 2 hours) or specify no refresh.

 8 Generate or Save the Query

➤ If accessing the Custom Query Builder directly from the User Reports 
context, click Generate to generate a report based on the selected data. 
The report appears beneath the Query Filter pane, and the Query Filter 
pane collapses. To edit the query or create a new query, expand the Query 
Filter pane. To view the report, you must collapse the Query Filter pane.

➤ If accessing the Custom Query Builder from the Custom Report Wizard, 
click OK in the Add Component dialog box to save the settings to your 
Custom Report. 

➤ If accessing the Custom Query Builder from My BAC, click Save to save 
the settings for the portlet.
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Tip: To create a URL query string, click the Export button , select Publish 
Report, specify the requested settings, and click the Generate URL button.

Reference

Custom Query Builder User Interface

This section describes:

 ➤  Custom Query Builder Page on page 202

 ➤  Presentation Settings Wizard on page 215
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Custom Query Builder Page

Description Enables you to: 

➤ Create queries to the profile database to generate 
reports. 

➤ Generate an HTML query string that can be used 
together with third-party tools or proprietary tools to 
extract data from the profile database.

To access: 

➤ Select Applications > User Reports > Custom Query 
Builder. 

➤ Select the Custom Query component category to add a 
Custom Query Builder report to a Custom Report. For 
details on Custom Reports, see “Custom Reports” on 
page 123.

➤ Select the Custom Query portlet in My BAC. For 
details on configuring a portlet in My BAC, see “Add 
Portlets to <page_name>/Add Portlets Dialog Box” in 
Using My BAC.

Important 
Information

➤ If you leave the Custom Query Builder page while 
building a query, the query is lost. To avoid losing the 
query, click the Generate button to generate a report 
based on the query. After generating a report, if you 
move to a different page and then return to the 
Custom Query Builder page, the last query built prior 
to report generation is available.

➤ Once you log out of your current Web session, the 
query is lost.

➤ When accessing the Custom Query Builder window 
from the Custom Report Manager, the query is lost as 
soon as you close the window, unless you click OK to 
save it.

➤ To create a URL query string, select Export > Publish 
Report, specify the requested settings, and click the 
Generate URL button.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks “Build a Custom Query – Workflow” on page 198

Useful Links “Custom Query Builder - Overview” on page 197

“Common Report Elements” on page 51

GUI Element (A-Z) Description

Click to open the <Field alias> Field Properties dialog box 
and modify field properties, if required. For details, see 
“<Field alias> Field Properties Dialog Box” on page 206.

<Common Report 
Settings>

For details, see “Common Report Elements” in Reports.

Alias Name Modify the alias name for the selected field, if required. 
For example, if you chose AVG from the Function list, 
modify the alias name to say Avg Response Time. 

Clear Filter Click to clear the filter string, if required. 

Edit Presentation Click to open the Presentation Settings Dialog Box and 
configure presentation settings. For details, see 
“Presentation Settings Wizard” on page 215.

Field Alias The value of the Alias name cell for the added field. 

Note: You can edit the value of this field directly in the 
Field Alias cell. 

Field Formula The value of the Function and Field name cells for the 
added field.

Note: You can edit the value of this field directly in the 
Field Formula cell. For example, to display returned 
response time in seconds rather than milliseconds, edit 
the field formula for Response Time, dResponseTime, as 
follows: dResponseTime / 1000.
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Field Name Select a data field that you want to extract from the 
database. 

Tip: When adding fields to the query, select them in the 
order in which you want the data columns to appear, 
from left to right, in the returned output. 

Filter Displays the configured filter string. 

Notes: 

➤ When a filter consists of strings containing white 
space or special characters (for example, where bb_guid 
IN (a b, c)), the white space or special character string 
must be enclosed with quotes (for example, where 
bb_guid IN (‘a b’, c)). When you create filters on the 
Filter Builder page, quotes are added automatically. 
Special characters are defined as any characters other 
than digits, letters, and the following characters: 
"_", "$", "#".

➤ When defining a filter that consists of strings 
containing one or more single quote characters, you 
must add a second single quote character beside each 
instance. For example, change szTransactionName = 
('Login_to_O'brien') to szTransactionName = 
('Login_to_O''brien')

Filter Builder Click to open the Filter Dialog Box and apply filters to 
the data being extracted by the query. For details, see 
“Filter Dialog Box” on page 213.

Function Select a function to perform on the data represented in 
the specified data field. For example, to return average 
response time, select Response Time from the Field name 
list and AVG from the Function list.

For a list of the supported functions, see “Supported SQL 
Syntax” in Solutions and Integrations.

GUI Element (A-Z) Description



Chapter 9 • Custom Query Builder

205

Generate Click to generate the report based on the selected data. 
The report appears beneath the Query Filter pane, and 
the Query Filter pane collapses. To edit the query or 
create a new query, expand the Query Filter pane. When 
the Query Filter pane is expanded, the existing report 
remains beneath it.

Note: This element is available only when accessing the 
Custom Query Builder from the User Reports menu. 

Return data per 
specified granularity

Select if you want returned data grouped according to a 
specific granularity setting (for example, if you want data 
for the past day grouped per hour), and specify a 
granularity setting.

Notes: 

➤ If you modify this setting after configuring 
presentation settings, the presentation settings are 
then lost. For details on presentation settings, see 
“Presentation Settings Wizard” on page 215.

➤ When selecting this field, it is recommended not to 
select the time_stamp field in the query. This is 
because, if Return data per specified granularity is 
selected, HP Business Availability Center automatically 
adds a time dimension to the report.

Sample type Select a data sample type. For a description of the 
available sample types, see “Data Samples” in Reference 
Information.

GUI Element (A-Z) Description
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<Field alias> Field Properties Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to modify the default field properties and 
define custom properties for the field.

To access: Click the Field Properties button  on the 
Custom Query Builder page. 

GUI Element (A-Z) Description

Critical Threshold Displayed for Double and Integer field types. Used to add 
color coding in tables and graphs to data for which 
thresholds in the system have been defined—for 
example, to display transaction response time data with 
color coding corresponding to the Critical threshold 
defined in System Availability Management. In tables, 
the color coding is in the form of colored cells. In graphs, 
the color coding is in the form of a colored line. For 
details on working with Critical Threshold settings, see 
“OK/Critical Thresholds” on page 210.

Format Displayed for Date, Double, and Integer field types. Used 
to customize the format of the displayed date or 
numerical data in data tables, as well as in graphs (x-axis, 
tooltips, legend). For a list of possible formats and syntax 
examples, see “Custom Query Builder User Interface” on 
page 201.

Max length Displayed only for String field type. Used to set a 
maximum length, in characters, for the displayed string. 
In cases where the string exceeds the defined length, a 
tooltip is shown with the complete string.
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Field Formats

You enter values in the Formats box to modify the default format for a field, 
as defined in the field’s metadata. For example, the default date format is 
M/dd/yy hh:mm:a, which displays the date_stamp data as 
5/22/06 11:25 AM. By changing the date format, you can modify the way 
the date_stamp data is displayed. 

You can also add a string beside the returned data, for example, the literal 
string "ms" after returned response time data. The allowed formats are based 
on Java formatting classes. 

OK Threshold Displayed for Double and Integer field types. Used to add 
color coding in tables and graphs to data for which 
thresholds in the system have been defined—for 
example, to display transaction response time data with 
color coding corresponding to the OK threshold defined 
in System Availability Management. In tables, the color 
coding is in the form of colored cells. In graphs, the color 
coding is in the form of a colored line. For details on 
working with OK Threshold settings, see “OK/Critical 
Thresholds” on page 210.

Type The default type for the field is initially displayed.

Example: By changing a field type from Double to 
Integer, you can display the returned data without the 
decimal point, if you use a function to modify a field 
formula in a way that results in a numerical value 
becoming a string. For example, if you change 
(dResponseTime) to IF(dResponseTime,>,5000,pass,fail), 
you must change the type to String to enable the 
returned result to display correctly in a table.

The following field types exist: 

➤ String. Used for textual expressions.

➤ Date. Used for date fields.

➤ Double. Used for numerical fields.

➤ Integer. Used for numerical fields.

GUI Element (A-Z) Description
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Some typical date/time formats include:

Symbol Meaning Type Examples

y Year Number yy > 06

yyyy > 2006

M Month Text or Number M > 7

M > 12

MM > 07

MMM > Jul

MMMM > 
December

d Day in month Number d > 3

d > 14

dd > 03

h Hour (1-12, 
AM/PM)

Number h > 3

h > 11

hh > 03

H Hour (0-23) Number H > 15

HH > 15

m Minute Number m > 7

m > 15

mm > 15

s Second Number s > 15

ss > 15

S Millisecond (0-
999)

Number SSS > 007

E Day in week Text EEE > Tue

EEEE" > Tuesday

a AM/PM Text a > AM

aa > AM
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Some typical decimal formats include:

z Time zone Text z > EST

zzz > EST

zzzz > Eastern 
Standard Time

' Escape for text Delimiter 'hour' h > hour 9

Symbol Meaning Examples

0 Shows a digit or 0 if no digit 
present

Value: 123.78 

Pattern: 000000.000 

Output: 000123.780 

# Shows a digit or nothing if no 
digit present

Value: 123.78 

Pattern: #.###

Output: 123.78 

. Indicates the decimal point Value: 123.78 

Pattern: #.##

Output: 123.78

, Used to group numbers Value: 4123.78 

Pattern: ,###.##

Output: 4,123.78 

' Used to quote a literal symbol Value: 123.78 

Pattern: '#'###.##

Output: #123.78

% Multiplies by 100 and shows as 
percentage

Value: 123.78 

Pattern: #%

Output: 12378%

Symbol Meaning Type Examples
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A complete reference to these classes is located on the Sun Web site, at the 
following URLs: 

➤ Date and Time Patterns. 
http://java.sun.com/j2se/1.4.2/docs/api/java/text/SimpleDateFormat.html

➤ Decimal Format Patterns. 
http://java.sun.com/j2se/1.4.2/docs/api/java/text/DecimalFormat.html

OK/Critical Thresholds

You enter values in the OK Threshold and Critical Threshold boxes to add 
color coding to your reports. Colors are added to the reports as follows:

➤ Green. For values corresponding to the specified OK Threshold value.

➤ Red. For values corresponding to the specified Critical Threshold value.

➤ Yellow. For values in between the specified OK Threshold and Critical 
Threshold values.

Example 1: Assuming your report is in table format, if you edit the field 
properties for transaction response time and specify 2000 ms for the OK 
Threshold and 4000 ms for the Critical threshold, all returned transaction 
response time values that are less than or equal to 2000 ms are colored 
green, all returned transaction response time values that are greater than or 
equal to 4000 ms are colored red, and all in-between values are colored 
yellow. This is the case even if, in System Availability Management, 
thresholds are defined differently.
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Example 2: Assuming your report is in graph format and average response 
time is selected for the y-axis, if you edit the field properties for transaction 
response time and specify 2000 ms for the OK Threshold and 4000 ms for 
the Critical threshold, a green line is drawn on the graph at the 2000 point 
and a red line is drawn on the graph at the 4000 point.

Two types of values can be entered in the OK Threshold and Critical 
Threshold boxes:

➤ Numerical values. You enter the actual values according to which you want 
data colored. Numerical values entered in the OK/Critical Threshold boxes 
will color code both data tables (cells whose values are within a specific 
threshold range are colored accordingly) and graphs (a colored line 
representing the specified value is added to the graph). The values that you 
enter override any actual set threshold values. 
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Note: When editing the query presentation format to return a graph, if you 
configure multiple y-axes on the same graph, no colored line is displayed. 
For details on editing presentation see “Presentation Settings Wizard” on 
page 215.

➤ Referenced fields. You enter the exact field alias of two other fields that have 
been added to the query. The values of the referenced fields must be 
numerical. Typically you add threshold fields such as Green Threshold and 
Red Threshold. Referenced fields entered in the OK/Critical Threshold boxes 
will color code only data tables (cells whose values are within a specific 
threshold range are colored accordingly). Graphs will not be color coded.

The following logic is used when determining how to interpret the values 
placed in the OK Threshold and Critical Threshold boxes to correctly apply 
color to the reports:

➤ If the numerical value or value of the referenced field entered in the OK 
Threshold box is lower than the numerical value or value of the referenced 
field entered in the Critical Threshold box, HP Business Availability Center 
assumes that lower values are OK and higher values are Critical (for 
example, response time). Data is colored accordingly.

For example, under this assumption, values returned for the field whose 
properties you are editing that were less than or equal to the numerical 
value or value of the referenced field specified in the Green Threshold box 
would be colored green.

➤ If the numerical value or value of the referenced field entered in the OK 
Threshold box is higher than the numerical value or value of the referenced 
field entered in the Critical Threshold box, HP Business Availability Center 
assumes that higher values are OK and lower values are Critical (for 
example, measurement of disk space). Data is colored accordingly.

For example, under this assumption, values returned for the field whose 
properties you are editing that were less than or equal to the numerical 
value or value of the referenced field specified in the Red Threshold box 
would be colored red.
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Filter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to apply filters to the data being extracted by 
the query. 

To access: Click the Filter Builder button on the Query 
Filter pane. 

Important 
Information

➤ When a filter consists of strings containing white 
space or special characters (for example, where bb_guid 
IN (a b, c)), the white space or special character string 
must be enclosed with quotes (for example, where 
bb_guid IN (‘a b’, c)). When you create filters on the 
Filter Builder page, quotes are added automatically. 
Special characters are defined as any characters other 
than digits, letters, and the following characters: 
"_", "$", "#".

➤ When defining a filter that consists of strings 
containing one or more single quote characters, you 
must add a second single quote character beside each 
instance. For example, change szTransactionName = 
('Login_to_O'brien') to szTransactionName = 
('Login_to_O''brien')

GUI Element (A-Z) Description

Add Values Click when available to select from a predefined list of 
values. The Add Values button is enabled for fields whose 
lookup value is defined as true in the sample metadata in 
the database (generally for final, discreet values).

And Click to add an additional And filter. 

Field Select a field to which you want to apply a filter. For 
example, select Profile Name to filter the query to only 
return data for specific profiles (rather than all profiles in 
the database), or select Response Time to filter the query 
to return only response time data above or below a 
specific value (rather than all response times).
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Operator Select the required operator. For a description of the 
supported operators, see “Supported SQL Syntax” in 
Solutions and Integrations.

Note: The LIKE operator does not work for the Profile 
Name field.

Value Specify the required value. For example, if you are 
filtering the query by transaction name, specify a specific 
transaction. If you use the LIKE operator, you can use the 
* wildcard character to return like results (for example, a 
value of *westcoast* would return all transactions whose 
name included the string westcoast).

Add ’OR’ Expression Click to add Or filters. 

GUI Element (A-Z) Description
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Presentation Settings Wizard 

Description Enables you to configure the presentation display of your 
Custom Query. 

To access: Click the Edit Presentation button on the 
Query filter pane. 

Important 
Information

The pages that appear on the Presentation Settings 
Wizard depend on the option you select in the Choose 
Presentation View page and the Choose Table Type page.

Included in Tasks “Build a Custom Query – Workflow” on page 198

Wizard Map The Presentation Settings wizard contains the following 
pages, depending on whether you chose Table view or 
Graph view on the Choose Presentation View Page of the 
wizard:

➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort Field 
Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 197

“Custom Query Builder Page” on page 202
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Choose Presentation View Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to choose the layout of the Custom Query 
presentation. 

To access: Click the Edit Presentation button on the 
Query filter pane. 

Important 
Information

➤ The resulting Wizard pages that appear depend on the 
Presentation View option you choose. 

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 215.

Included in Tasks “Build a Custom Query – Workflow” on page 198

Wizard Map The Presentation Settings Wizard wizard contains:

➤ Table View: Choose Presentation View Page > 
Choose Table Type Page > (Select Field Order Page) > 
(Sort Field Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 197

“Custom Query Builder Page” on page 202

GUI Element (A-Z) Description

Graph Select to view the Custom Query presentation in graph 
format. 

Table Select to view the Custom Query presentation in table 
format.



Chapter 9 • Custom Query Builder

217

Choose Table Type Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to choose the type of table in which the 
Custom Query is displayed. 

To access: Select Table on the Choose Presentation View 
page in the Presentation Settings wizard. 

Important 
Information

➤ The resulting Wizard pages that appear depend on the 
Table type you chose. 

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 215.

Included in Tasks “Build a Custom Query – Workflow” on page 198

Wizard Map The Presentation Settings Wizard wizard contains:

➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort 
Field Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 197

“Custom Query Builder Page” on page 202

GUI Element (A-Z) Description

Pivot Select to display the Custom Query table as a table that 
can include multiple fields in a spreadsheet type of 
matrix.

Regular Select to view the Custom Query table as a standard table 
with a column for each field in the query.
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Select Field Order Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the order of the Custom Query 
fields to appear in your table. 

To access: Select Regular on the Choose Table Type page 
in the Presentation Settings wizard. 

Important 
Information

➤ This page appears only if you selected Regular on the 
Choose Table Type page. 

➤ The uppermost field in the Available Fields dialog box 
appears on the left side of the table, and the 
lowermost field appears on the right side of the table. 

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 215.

Included in Tasks “Build a Custom Query – Workflow” on page 198

Wizard Map The Presentation Settings Wizard wizard contains:

➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort 
Field Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 197

“Custom Query Builder Page” on page 202

GUI Element (A-Z) Description

Click to move the selected field up in the Available Fields 
list, for it to be moved to the left side of the table. 

Click to move the selected field down in the Available 
Fields list, for it to be moved to the right side of the table. 

Available Fields Displays the fields selected on the Custom Query Builder 
Main Page to be included in your Custom Query. 
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Sort Field Order Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the fields by which you want to sort 
the table. order of the Custom Query fields to appear in 
your table. 

To access: Select the order of fields to appear in the table 
on the Select Field Order page, and click Next. 

Important 
Information

➤ This page appears only if you selected Regular on the 
Choose Table Type page. 

➤ Fields are sorted first by the topmost field in the Sorted 
Fields dialog box, then by the next field, and so on.

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 215.

Included in Tasks “Build a Custom Query – Workflow” on page 198

Wizard Map The Presentation Settings Wizard wizard contains:

➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort 
Field Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 197

“Custom Query Builder Page” on page 202

GUI Element (A-Z) Description

Click to move the selected field to the Sorted Fields box.

Click to move all available fields to the Sorted Fields box.

Click to remove the selected field from the Sorted Fields 
box.
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Click to remove all fields from the Sorted Fields box.

 Click to move the selected field up in the sort hierarchy. 
Fields are first sorted by the topmost field, then by the 
next, and so on. 

Click to move the selected field down in the sort 
hierarchy. Fields are first sorted by the topmost field, 
then by the next, and so on. 

Click to sort the fields in the Sorted Fields box in 
ascending order. 

Click to sort the fields in the Sorted Fields box in 
descending order. 

Available Fields Displays the fields selected on the Custom Query Builder 
Main Page available to be sorted. 

Sorted Fields Displays the fields that are to be sorted in the Custom 
Query. Fields are first sorted by the topmost field, then by 
the next, and so on. 

GUI Element (A-Z) Description
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Table Definition Page

Description Enables you to select the fields by which you want to sort 
the table. order of the Custom Query fields to appear in 
your table. 

To access: Select the order of fields to appear in the table 
on the Select Field Order page, and click Next. 

Important 
Information

➤ This page appears only if you selected Pivot on the 
Choose Table Type page. 

➤ If Return data per specified granularity is selected for 
the query, HP Business Availability Center adds Time 
to the list of available fields in the Table Definition 
Page. 

➤ Fields are sorted first by the topmost field in the Sorted 
Fields dialog box, then by the next field, and so on.

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 215.

Included in Tasks “Build a Custom Query – Workflow” on page 198

Wizard Map The Presentation Settings Wizard wizard contains:

➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort Field 
Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 197

“Custom Query Builder Page” on page 202
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to move the highlighted key column to the 
Selected Key Columns dialog box.

Click to move all key columns to the Selected Key 
Columns dialog box.

Click to remove the highlighted key column from the 
Selected Key Columns dialog box.

Click to remove all key columns from the Selected Key 
Columns dialog box.

Click to move the selected key column down in the 
Selected Key Columns dialog box, and specify the order 
in the table. The topmost key column appears on the left, 
then the next key column, an so on. 

 Click to move the selected key column up in the Selected 
Key Columns dialog box, and specify the order in the 
table. The topmost key column appears on the left, then 
the next key column, an so on. 

Across Column Select a field for the Across Column. Each unique value 
returned for that field is displayed in a separate column 
in the table. Examples of useful fields to select for the 
across column include time, location, or any other field 
that returns a relatively small number of data points that 
are useful to compare one to another.
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Available Key 
Columns

Select one or more fields, and move them to the Selected 
Key Columns list by clicking the relevant right arrow key. 
Consider selecting fields that contain data that you want 
to compare against the field selected in the across 
column. For example, in a query filtered to one specific 
transaction, if you selected time for the across column 
and average response time for the value column, you 
could select location and host fields as key columns; this 
would enable you to directly compare average response 
time of a transaction for various hosts at different 
locations at specific points in time.

Note: The fields that remain in the Available Key 
Columns box still exist in the query, but are hidden in 
the report table returned by the query.

Selected Key 
Columns

Displays the fields selected from the Available Key 
Column list. Each selected field will be displayed in the 
table, to the left of the field selected for the Across 
Column. You can remove individual or all selections by 
clicking the left arrow keys. 

Value Field Select a field for the value field. It is recommended that 
you select a field that returns a meaningful numerical 
value, for example, response time. Do not select date-
related fields such as Time or time_stamp. 

GUI Element (A-Z) Description
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Choose Graph Type Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to choose the type of graph for the Custom 
Query to be displayed in. 

To access: Select Graph on the Choose Presentation View 
page in the Presentation Settings wizard.

Important 
Information

➤ The resulting Wizard pages that appear depend on the 
Table type you chose. 

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 215.

Included in Tasks “Build a Custom Query – Workflow” on page 198

Wizard Map The Presentation Settings Wizard wizard contains:

➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort Field 
Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 197

“Custom Query Builder Page” on page 202

GUI Element (A-Z) Description

Bar Select to view the Custom Query in Bar Graph format.

Line Select to view the Custom Query in Line Graph format.
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Define Graph Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to specify the layout of the graph in which 
the Custom Query is displayed. 

To access: Select Bar or Line on the Choose Graph Type 
page in the Presentation Settings wizard.

Important 
Information

General information about the wizard is available in 
“Presentation Settings Wizard” on page 215.

Included in Tasks “Build a Custom Query – Workflow” on page 198

Wizard Map The Presentation Settings Wizard wizard contains:

➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort Field 
Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 197

“Custom Query Builder Page” on page 202

GUI Element (A-Z) Description

Click to move the highlighted dimension to the Selected 
Dimensions list.

Click to move all key columns to the Selected Key 
Columns list.

Click to remove the highlighted key column from the 
Selected Key Columns list.

Click to remove all key columns from the Selected Key 
Columns list.
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Click to move the selected key column down in the 
Selected Key Columns list., and specify the order in the 
table. The topmost key column appears on the left, then 
the next key column, an so on. 

 Click to move the selected key column up in the Selected 
Key Columns list, and specify the order in the table. The 
topmost key column appears on the left, then the next 
key column, an so on. 

Available Dimensions Optionally, select one or more dimensions for the graph. 
If no dimensions are selected, the y-axis value is used as 
the single dimension. 

Note: The fields that remain in the Available Dimensions 
box are not sent as part of the query and do not appear in 
the report.

Max. Scale Optionally, specify a maximum value for the y-axis scale. 

Min. Scale Optionally, specify a minimum value for the y-axis scale. 

Selected Dimensions The dimensions that have been selected to appear in the 
graph. The data for a field selected as a dimension is 
displayed on the graph separately, differentiated using a 
color coding. 

GUI Element (A-Z) Description
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X-axis Select a field to display on the x-axis. Both numerical 
fields and strings are supported.

Note: If Return data per specified granularity is selected 
for the query, HP Business Availability Center defines the 
x-axis as Time. This cannot be modified. 

Y-axis Select one or more numerical fields to display on the y-
axis (only numerical fields are supported). Fields selected 
for the y-axis are removed from the Dimensions list.

➤ If multiple y-axis fields are selected but no dimensions 
are selected, one single graph is displayed with all the 
fields on the same y-axis. For the graph with multiple 
y-axis fields to be meaningful, consider selecting fields 
whose values are comparable.

➤ If multiple y-axis fields are selected and one or more 
dimensions are selected, a separate graph is displayed 
for each separate y-axis.

GUI Element (A-Z) Description
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10
Excel Reports

This chapter explains how to use the capabilities of Microsoft Excel to build 
and view customized reports in HP Business Availability Center.

This chapter includes:

Concepts

 ➤  Configuring Excel Reports on page 229

Tasks

 ➤  Create a Microsoft Excel Report - Workflow on page 230

 ➤  Create a Microsoft Excel Web Query File on page 231

 ➤  Generate a Report with Microsoft Excel on page 232

Reference

 ➤  Example of a Web Query on page 233
Concepts

Configuring Excel Reports

You can build and view customized reports in HP Business Availability 
Center that take advantage of the charting abilities of Microsoft Excel, to 
display various types of data collected by HP Business Availability Center 
data collectors. The reports can be viewed with Microsoft Excel or any 
spreadsheet program capable of reading files with the .xls format. You 
cannot export information from charts into Microsoft Excel. For details on 
creating a Microsoft Excel Report, see “Create a Microsoft Excel Report - 
Workflow” on page 230.
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Note: Contact HP Software-as-a-Service Support for details on implementing 
Microsoft Excel reports in HP Software-as-a-Service. 

Tasks

Create a Microsoft Excel Report - Workflow

This task describes how to create Microsoft Excel reports that include 
HP Business Availability Center data:

This task includes the following steps:

➤ “Write a Query” on page 230

➤ “Save the Query” on page 230

➤ “Generate a Report with Microsoft Excel” on page 230

➤ “Upload the Microsoft Excel Report to the Report Manager” on page 231

➤ “View the Microsoft Excel Report” on page 231

 1 Write a Query
Write a query that retrieves data from the HP Business Availability Center 
profile database. For details on writing queries, see “Working with the 
Generic Reporting Engine API” in Solutions and Integrations.

 2 Save the Query
Save the query in a Web Query file. For details, see “Create a Microsoft Excel 
Web Query File” on page 231.

 3 Generate a Report with Microsoft Excel
Create a Microsoft Excel report. For details, see “Generate a Report with 
Microsoft Excel” on page 232.
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 4 Upload the Microsoft Excel Report to the Report Manager
Click the New button in the Report Manager and select New Excel Report to 
open the Excel Report dialog box and upload the Microsoft Excel report to 
the Report Manager. For details, see “New Excel Report Page” on page 120.

 5 View the Microsoft Excel Report
Select the Microsoft Excel Report in table on the Report Manager main page 
and click the view button to view the report.

Create a Microsoft Excel Web Query File

This task describes how to create a text file with an .iqy (IQY) extension that 
you then import into Excel.

To create an .iqy file:

 1 Open an empty file in a text editor and copy the following content into the 
file:

 2 Locate the query you created and place it in the file instead of the line 
<query_url_goes_here>. 

 3 Save the text file with an .iqy (IQY) extension.

For an example of a query that extracts data from the profile database, see 
“Example of a Web Query” on page 233.

WEB
1
<query_url_goes_here>

Selection=EntirePage
Formatting=None
PreFormattedTextToColumns=True
ConsecutiveDelimitersAsOne=False
SingleBlockTextImport=False
DisableDateRecognition=False
DisableRedirections=False
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Generate a Report with Microsoft Excel 

This task describes how to generate a report with Microsoft Excel. 

To generate a report with Microsoft Excel:

 1 Open a new Microsoft Excel file.

 2 Select cell A1.

 3 In Microsoft Excel 2002 or 2003, select Data > Import External Data > 
Import Data. Microsoft Excel opens the Select Data Source dialog box. Select 
the .iqy file you created (“Create a Microsoft Excel Web Query File” on 
page 231) and click Open. Excel opens the Import Data dialog box.

In Microsoft Excel 2000, select Data > Get External Data > Run Saved Query. 
Microsoft Excel opens the Run Query dialog box. Select the .iqy file and click 
Get Data. Excel opens the Returning External Data to Microsoft Excel dialog 
box.

 4 Select Existing worksheet, and check that the value =$A$1 is selected.

 5 Click Properties. Microsoft Excel opens the External Data Range Properties 
dialog box.

 6 Make sure the following settings are configured:

➤ refresh data on file open

➤ remove external data from worksheet before saving

➤ overwrite existing cells with new data, clear unused cells

 7 Click OK. Microsoft Excel closes the External Data Range Properties dialog 
box and displays the Import Data dialog box (Returning External Data to 
Microsoft Excel dialog box in Excel 2000).

 8 Click OK to retrieve the data.

 9 Use Microsoft Excel’s charting features to format the report, as required.

 10 Name the file and save the Microsoft Excel workbook to a temporary 
location.

Reference
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Example of a Web Query

The following is an example of a typical Web query file. This example 
illustrates the retrieval of a list of rum_server_t samples that failed in any 
given day:

To use this example:

 1 Type or copy the text from the above example into a text editor.

 2 Edit the URL beginning on the third line of the file as required. Leave all 
other values as shown.

 3 Save the file with an .iqy extension.

WEB
1
http://myServer.mydomain/topaz/gdeopenapi/GdeOpenApi?method=getData&user=ad
min&password=admin&query=select time_stamp, engine_name, server_name from 
rum_server_t where availability=0 and total_hits > 0 and time_stamp>1041379200 and 
time_stamp<1136197020

Selection=EntirePage
Formatting=None
PreFormattedTextToColumns=True
ConsecutiveDelimitersAsOne=False
SingleBlockTextImport=False
DisableDateRecognition=False
DisableRedirections=False
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